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PREFACIO

Es impresionante ver como en pocos afios la forma de vivir de los humanos ha cambiado drasticamen-
te, podemos ver atras y darnos cuenta que hace unos 40 afios no se disponia de las comodidades tecnologi-
cas que ahora tenemos, todo era mas arcaico, mas mecanico. El impacto que ha tenido la electronica en
nuestro mundo es impresionante, nadie puede dudarlo. Muchas investigaciones se han realizado en el trans-
curso de varios aflos, experimentos incontables donde se demuestra la teoria que los respalda, desarrollo de
aplicaciones, desarrollo de mas teorias, implementacion de maquinas que facilitan el estudio y la investiga-
cion, todos estos esfuerzos fueron necesarios para tener lo que ahora tenemos: un mundo tecnolégicamente
moderno.

Son diversos los campos en donde se han realizado mejorias significativas: en automatizacion, en tele-
comunicaciones, biotecnologia, almacenamiento de datos, procesamiento de datos a alta velocidad, proce-
samiento multimedia etc. Todos estos campos son mejorados afio con afio, pero todo es debido a la mejora
absoluta de la fabricacion de los circuitos integrados que componen cada uno de los equipos electronicos
que se usan para realizar alguna tarea. Desde la creacion del transistor en 1947 la historia de la humanidad
cambio, todo fue mejorandose exponencialmente, integrando mas y mas componentes en espacios cada vez
mas pequefios. Very Large Scale Integration (VLSI) es el término que se usa en la actualidad para definir
esta integracion a muy gran escala de componentes en una oblea de silicio que es considerablemente pe-
quefia.

VLSI es el tema de este documento, se analizaran aplicaciones de disefio que han permitido la realiza-
cion de circuitos integrados tan pequefios y cada vez mas eficientes en su labor. Esta rama de la electrénica
nunca ha sido tratada en Guatemala por lo que este trabajo puede ser el gran comienzo del desarrollo de
Guatemala en el mundo de la nanoelectronica. En el transcurso de la realizacion de este trabajo se hara la
implementacion del servidor de licencias de las aplicaciones que seran nuestro arsenal para el desarrollo de
un sumador/restador de 32 bits en un proceso de manufacturacion de 28 nanémetros. El fin es proveer al
laboratorio de electronica de aplicaciones profesionales desarrolladas por Synopsys para el disefio VLSI,
también hacer menos complicada para los futuros disefiadores su labor, realizando manuales de usuario y
tutoriales sobre el uso de las aplicaciones.

Es importante mencionar que las licencias de las aplicaciones de Synopsys fueron obtenidas gracias a
la institucion Universidad del Valle de Guatemala que atendi6 a la idea del director del departamento de
Ingenieria Electronica de la misma institucion, el Ingeniero Carlos Esquit Hernandez que es el asesor de
este trabajo de graduacion. Agradezco en gran manera a la Universidad del Valle de Guatemala y al inge-
niero Carlos Esquit por estar siempre en busca de la excelencia en la educacion del pais y permitirme inves-
tigar y aventurarme en este nano pero inmenso universo.

Para Tony y Augusto...
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RESUMEN

La nanoelectrénica es el estudio de los procesos que se requieren para el disefio e implementacion de
un circuito con una integracion a muy gran escala (VLSI) de sus componentes. Una ciencia innovadora ya
que con ella se ha logrado un avance considerable de los dispositivos que se usan en las grandes industrias
como en nuestro diario vivir. Este trabajo universitario introduce a la institucion educativa Universidad del
Valle de Guatemala en el disefio de aplicaciones a muy gran escala, con tecnologia de vanguardia y softwa-
re profesional del proveedor Synopsys, una de las grandes empresas de desarrollo en este ambito.

El trabajo consiste en empezar de cero la instalacion de las aplicaciones en el laboratorio de electronica
de la universidad, para esto fue necesaria la configuracion de un servidor de licencias y de los clientes.
Usando como plataforma una distribucion de Linux llamada CentOS version 6.4 que es recomendada para
estos fines. Se siguieron las instrucciones dadas por Synopsys para la instalacion de todo el entorno y pos-
teriormente, cuando las aplicaciones estaban completamente funcionales se usaron los manuales y ayuda de
cada aplicacion para el uso correcto. Durante el proceso de aprendizaje se realizaron guias rapidas para el
uso de las aplicaciones, esto beneficiara la curva de aprendizaje de nuevos disefiadores, centrandose en
realizar un buen disefio y no invertir mucho tiempo revisando extensos manuales. Estas guias de uso de las
aplicaciones constituyen gran parte del marco teorico de este trabajo.

Synopsys tiene un programa universitario para el aprendizaje de esta rama de la electrénica y por esta
razoén provee una libreria muy completa para el disefio eficiente, la experimentacion, y la investigacion.
Esta libreria se us6 como parte final del trabajo de graduacion para realizar un proyecto de dificultad me-
dia, un sumador/restador de 32 digitos binarios. Esta libreria contiene todo lo necesario para el desarrollo
con un proceso de 32-28 nandometros y esta avalada por la gran empresa foundry TSMC, por lo que es ideal
para la enseflanza universitaria. El proceso de disefio fue exitoso como se mostrara en la seccion de resulta-
dos donde también se muestran parametros propios del disefio como retraso de propagacion, potencia,
energia y la densidad de transistores en el disefio final. (TSMC, 2014)
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I. INTRODUCCION

Las aplicaciones de disefio de circuitos integrados son de gran utilidad, estos circuitos pueden aseme-
jarse a cualquier otro en cuanto a funcionamiento final, pero durante el proceso de disefio es necesario
tomar muchos factores en cuenta. El proceso de fabricacion de estos circuitos es bastante complejo, se usan
maquinas muy precisas para lograr la manufacturacion de componentes tan pequefios. Para que el lector se
haga una idea de lo impresionante que puede llegar a ser este mundo se deja una grafica, donde se muestran
algunos datos de como ha mejorado este proceso a lo largo del tiempo. (Farrow, 2011)

Figura 1: Cantidad de transistores en distintos procesadores
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La cantidad de transistores que se ha logrado integrar en una pequefia pieza de silicio en los tiempos
actuales es impresionante, tomando en cuenta que en 1971 el procesador 4004 tenia aproximadamente 2300
transistores y uno de los procesadores de unos 43 afios después tiene mas de 2,600,000,000 transistores,
denota un crecimiento y mejora impresionante.

Normalmente se hara referencia a la palabra die, que es un término usado en esta ciencia para referirse
a la parte del circuito integrado que forma todos sus transistores y todas las capas de metal que se usan para
interconectar a cada uno. Por ejemplo la siguiente figura muestra un die. (Xedoloh, 2011)



Figura 2: Die de procesador i7

Con el pasar del tiempo no solo las maquinas que implementan los die’s se han mejorado, sino que
también las aplicaciones de disefio de estos mismos han mejorado considerablemente, la combinacion de
estas grandes mejoras ha dado como resultado la elaboracion de circuitos muy complejos como el procesa-
dor mencionado con anterioridad. Este trabajo se centra en la manipulacion de estas aplicaciones de disefio,
el proyecto aqui disefiado no sera implementado.

En la actualidad en Guatemala no se presenta ninguna institucién educativa o empresa comercial que se
dedique a la investigacion de esta clase de temas, del disefio con integracion a muy gran escala. El principal
fin de este trabajo es dejar en el laboratorio de electronica de la Universidad del Valle de Guatemala un
conjunto de aplicaciones de disefio VLSI, que permita a estudiantes interesados en el tema hacer investiga-
cion, experimentacion y disefio eficiente y profesional de circuitos a nanoescala. En el transcurso del mon-
taje fisico y la instalacion de las aplicaciones se aprenderan a usar algunas elaborando un proyecto basico,
pero que es una parte vital de un procesador: un sumador y restador de nimero binarios de 32 bits. Como es
de suponerse, en el transcurso de la elaboracion del proyecto se aprendera a usar las aplicaciones, siendo la
primera aplicacion desarrollada con estas aplicaciones en el pais se toma la obligacion de realizar guias de
uso rapido de las aplicaciones que se usen en el proceso de disefio. Esto con el fin de hacer mas répido el
aprendizaje de nuevos ingenieros disefiadores.

Como ya se ha mencionado, el proyecto se limita al disefio y nunca se ha pensado en implementar el
proyecto por cuestiones de tiempo y costo, también se limita al uso de las librerias que Synopsys provee,
estas librerias son de gran utilidad para el disefio eficiente ya que consisten circuitos conocidos que ya estan
implementados, por ejemplo una compuerta NAND que ya trae archivos que la caracterizan y la definen
como su netlist que es la definicion del circuito en texto plano, modelos de Hspice, layout de la compuerta
(die) entre algunas otras utilidades que ayudan a acelerar el proceso de disefio. La idea del uso de librerias
es usada alrededor del mundo de una u otra forma, si no fuera asi tardarian cientos de afos en la realizacion
de un procesador. Imagine poner 2,600,000,000 transistores uno por uno en el proceso de disefio.

La metodologia empleada es simple y puede resumirse en algunos pasos. 1.) Levantar el servidor de li-
cencias 2.) Instalacion correcta de las aplicaciones que se vayan a utilizar 3.) Aprender el uso de las aplica-
ciones 4.) Seguir el flujo de disefio que Synopsys recomienda para la realizacion del proyecto 5.) Imple-
mentacion de pad ring. Se espera tener el die del sumador restador de 32 bits completamente funcional y
que cumpla con las reglas de disefio de la libreria de Synopsys que como ya se ha dicho son aprobadas por
la TSMC para la investigaciéon y experimentacion. Las conclusiones importantes de este trabajo son el
tiempo de retraso por propagacion del circuito final, la densidad de transistores lograda en el die, la energia



y la potencia disipada por el circuito. También se toma en cuenta la realizacion del denominado pad ring
que se usan para conectar el die al empaquetado, por la aplicacion se decidid usar pads tipo wire bond. Este
tipo de conexion al exterior tiene los pines externos alrededor del empaquetado y no debajo (flip chip) co-
mo es usual en los microprocesadores de Intel por ejemplo. (Journal, 2003)

Figura 3: Wire bond (izquierda) Flip Chip (derecha)

PSS
pay.
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Conforme el ingeniero desarrollador avanza y su conocimiento crece, se da cuenta de lo mucho que
queda por recorrer, la cantidad de informacién encontrada en la nanoelectronica puede representar una vida
entera de estudio y dedicacion, este trabajo presenta el inicio de ese recorrido. A continuacion se presentan
las secciones donde se muestra la investigacion realizada, en el marco tedrico se encontraran las guias rapi-
das de disefio e informacion tedrica adicional, ademas si gusta puede visitar la seccion de anexos donde se
presenta un espacio en linea donde se ha posteado un pequefio video tutorial que puede hacer el aprendiza-
je mas eficiente. Tome en cuenta que tanto las guias que se presentan en este trabajo y el video tutorial es
basico y para operaciones mas especificas no hay mejor fuente de informacion que los manuales oficiales
de las aplicaciones que las provee Synopsys en su portal.






II. OBJETIVOS

A. Generales

Montar un servidor de licencias que permita el uso correcto de las aplicaciones profesionales
para el disefio VLSI de empresa Synopsys y realizar la implementacion de una aplicacioén con
acabado profesional usando estas aplicaciones.

B. Especificos

N =

Proveer al laboratorio de electrénica de aplicaciones profesionales para el disefio VLSI.
Realizar una guia rapida para el uso correcto de las diferentes aplicaciones que se vayan a uti-
lizar.

Disefiar un sumador/restador completo de 32 bits usando las aplicaciones de Synopsys insta-
ladas en un proceso de fabricacion de 28 nanémetros.

Realizar un disefo eficiente del sumador/restador aplicando el método de Logical Effort.
Disefiar el sumador/restador tomando en cuenta el efecto de los retrasos ocasionados por el
cableado del layout final usando parasitic extraction.

Implementar el pad ring apropiado para conectar el die a un empaquetado.

Obtener el disefio del sumador/restador de 32 bits listo para ser fabricado, con las reglas de
disefo de la empresa Taiwan Semiconductor Manufacturing Company, Limited. (Synopsys,
TSMC - Synopsys Collaboration, 2014)






II. JUSTIFICACION

Desde hace muchos afios la electronica ha ido revolucionando la industria, es la culpable de muchas
herramientas que usamos en diario vivir que sin duda hacen mas facil nuestras vidas, optimizaciones de
procesos, procesamiento de datos masivos a gran velocidad, telecomunicaciones y un sinfin de aplicacio-
nes. La famosa Ley de Moore se ha cumplido con mucha exactitud, aunque con la mejora en los procesos
de manufacturacion de las empresas dedicadas a la fabricacion de semiconductores esta llamada ley podria
peligrar (Pepone, 2014). Esto no hubiera sido posible sin el desarrollo y constante mejora de los circuitos
integrados logrando tener una integracion a muy grande escala cominmente llamada VLSI. Este campo de
estudio, sin tan siquiera ser explotado en nuestro pais Guatemala, aparte de presentar un mundo de oportu-
nidades afiade una gran cantidad de conocimiento al estudiante de verdadera importancia en su vida profe-
sional.

Como se ha mencionado ninguna institucién de nivel superior en el pais y de hecho muy pocos en La-
tinoamérica (Argentina, México, Brasil) (Andénimo, 2002) cubre este importante tema y es necesario empe-
zar a impartirlo. Lo que se busca en este trabajo es instalar en el laboratorio de ingenieria electronica una
serie de aplicaciones profesionales dedicadas al disefio VLSI, también se aprenderan a utilizar estas aplica-
ciones y se realizara un sumador/restador de 32 bits que es una parte vital de un microprocesador y se deja-
ra listo para su fabricacion o para ser implementado en otras aplicaciones, este es otro de los fines del traba-
jo. El aporte es significativo en la universidad ya que se esta rompiendo una barrera importante en la edu-
cacion superior ya que se dara paso a una parte de la electronica que mundialmente necesita ser explorada y
explotada, con muchos temas de investigacion y desarrollo.






III. MARCO TEORICO

En este capitulo se presenta toda la teoria que se necesitd para poder desarrollar todo el proyecto, basi-
camente se trata de una sintesis de los procesos descritos en los manuales que provee Synopsys, es impor-
tante recalcar que se menciona solamente lo necesario ya que es imposible poder recabar toda la informa-
cion de estos manuales en este texto, ademads, hay temas que van fuera del alcance del mismo como texto
introductorio. La universidad del Valle en el departamento de electronica ha adquirido 87 aplicaciones
dedicadas para muchas funciones especificas en el mundo de la nanoelectronica, en este trabajo se usaran
algunas aplicaciones que se usan para algin proceso estdndar de disefio e implementacion y no se usan
aplicaciones muy especificas.

Respecto al sistema operativo utilizado se eligio el sistema operativo CentOS, este sistema operativo
podria decirse que es un clon de Red Hat ya que la comunidad desarrolladora utiliza el kernel de Red Hat
que ha sido publicado por la empresa para la creacion del mismo. La gran ventaja es que CentOS, aparte de
ser completamente gratuito es 100% compatible con las aplicaciones de Synopsys. Las siguientes secciones
presentan de forma ordenada guias rapidas para la instalacion y el uso de las aplicaciones.

A. Instalacion de CentOS

1. Prerrequisitos. Para la instalacion de CentOS se requieren que la computadora cumpla con
los siguientes requisitos:

Procesador x86_64 reciente.

Multiples CPUs o nucleos (un CPU con 4 o mas nucleos es recomendado)

CPU de 2GHz o superior.

4 GB de RAM.

Tarjeta Ethernet de 2 Gbps. (Synopsys, Synopsys Licensing QuickStart Guide, 2014)

oo oe

2, Proceso de instalacion. El proceso de instalacion de CentOS es basico, inicamente se si-
gue el asistente de instalacion que trae la version 6.4 del mismo, este asistente es muy grafico y no hay
forma de perderse en el proceso si se hace una instalacion basica, la inica complicacion podria surgir cuan-
do se requiera modificar las particiones donde se instalara, esto en el caso de tener un sistema operativo
extra en el disco duro y pretender tener un booteo dual en la maquina. Si se planifica tener un servidor
completamente en Linux y dedicar la Workstation para este fin se tiene un disco duro vacio y la instalacién
es un proceso simple. (Mamani, 2010)
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a. Elegir Install or upgrade an existing system en la pantalla de booteo.

Figura 4: Menu de booteo de CentOS

Welcome to CentOS 6.4!

[]nstall or upgrade an existing system
Install system with basic video driver
Rescue installed system

Boot from local drive

Memory test

Press [Tabl to edit options

CentOS 6

Community ENTerprise Operating System

b. Comprobar que el disco de instalacion no tenga errores.

Figura 5: Comprobacion de errores en disco

———} Bisc Found |——

To begin testing the media before
installation press BK.

Choose Skip tao skip the media test
and start the installation.

c. Elegir idioma del sistema operativo (algunos idiomas necesitaran la descarga de paquetes adi-

cionales).
Figura 6: Elecciéon de idioma

What language would you like to use during the

installation process?
Portuguese (Portuguss) =
Portuguese(Brazilian) (Portugués (Brasil))
Punjabi (37s)
Romanian (Romana)

Russian {(Pycckwid)

Serbian (cpnckn)
Serbian(Latin) (srpski(latinica))
sinhala (E3|E3|EEIEEIE)

Slovak (Sloventina)

Slovenian (slovenstina)

Spanish (Espaiiol)
Swedish (Svenska)
Tajik (Tajik)



d. Elegir la distribucion del teclado de acuerdo al hardware instalado en la PC.

c.

Figura 7: Distribucion de teclado

? Seleccione el teclado apropiado para
B el sistema.

Checo {qwerty)
Coreano

Croata

Danés

Danés (latinl)
Dvorak

Eslovaco {qwerty)
Esloveno

Estonio
Finlandés

Finlandés flatinl)

Elegir el tipo de almacenamiento que se tiene instalado en la PC.

f.

Figura 8: Tipo de almacenamiento

£Qué tipo de dispositivos involucra su instalacién?

Dispositivos de almacenamiento basicos
seguro de la opclon aproplada para usted, €sta es probablemente la correcta.

Dispositivos de almacenamiento especializados

® Instalaclones o actualizaclones para tlpos comunes de disposltivos de almacenamiento. Sl usted no estd

Instala o actualiza dispositivos de amprasa tales como Redes de drea de aimacenamiento (SAN). Esta

opclédn le parmitird atadir dlscos FCOE / ISCSI/ 2FCR y fiitrar 10s dIspositivos que &l Instalador debe
Ignorar.
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Asignar el nombre a la computadora. Este es el hostname de la PC, servira después en la
configuracion del servidor de licencias Synopsys.

Figura 9: Nombre de computadora

Por favor, de un nombre a esta computadora. EI
nombre de host identifica al computador en una red.

Nombre del host: (localhost.localdomain |
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g. Elegir un huso horario.

Figura 10: Huso horario

Por favor, seleccione la ciudad mas cercana a su huso horario:

Ciudad seleccionada: Madrid, Europa (area principal)

[Europa/Madrid C ]

h. Contrasefa para usuario root.
Nota: No olvidar esta contrasefia ya que es la del usuario (roof) con completo dominio del sis-
tema.

Figura 11: Contraseifia de superusuario

% La cuenta root se utlliza para la adminlistracién del
sa) sistema. Introduzca una contrasefia para el usuario root.

Contrasefia de root: [sessees ]

Confiman [ooo-o.- ]

i.  Elegir el tipo de particionamiento del disco duro. Se recomienda usar un disco duro en blanco
y usar todo el espacio del mismo, si no es posible lo recomendable es crear un disefio persona-
lizado de instalacion de particionamiento de disco duro.
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Figura 12: Particionamiento

¢Qué tipo de instalacién desea?

Usar todo el espacio
Ellmina todas las particlones £n los dispositivos selecclonadas. Esto Incluye las particlones creadas par
aotras sistemas aperativos.

05

®
Consejo: Esta opclan eliminara los datos de los dispositivos selecclonados. Aseglrese de hacer coplas
de seguridad.

Remplazar sistema(s) Linux existente(s}
L“_] Elimina sélo las particlones Linux (creadas desde una Instalaclon previa de Linux). Este no elimina otras
o particlones que tenga en sus dispositivos de almacenamiento (tales como VFAT o FAT32).

Conse)o; Esta opcidn eliminars los datos de los dispositivos selecclonados, Aseglrese de hacer coplas
de seguridad,

o (%]  Achicar el sistema Actual
Achica |as particlones existentes para dar campo al disefic predeterminado.

(os3  Usar el espacio libre
(@) Mantlene sus datos actuales y particlones, y usa solamente | espacio no particlonado en los
dispositivos selecclonados, asumlendo que hay espacio |ibre suficlente,

Crear un disaiio parsonalizado.
(@) Crear manualmente su prople disefic en los dispositivos selecclonados usando nuestra herramlenta de
particlonamlento.

Personalizar la instalacion. En este paso elegir la opcion Basic Server y la de “Personalizar
ahora”, en la personalizacion se agregan los programas que se desean instalar automaticamen-
te en el proceso de instalacion del sistema operativo. Se recomienda agregar un entorno grafi-
co para usar el servidor como cliente al mismo tiempo y aprovechar sus capacidades de hard-
ware en proyectos muy grandes. (Mamani, 2010)

Figura 13: Personalizacion de instalacion

O Desktop

O Minimal Desktop

@ Minimal

O Basic Server

O Database Server

O Web Server

O Virtual Host

O Software Development Workstation

Por favor, seleccione cualquier repositorio adicional que quiera usar para la instalacion de
software.

CentOS

<= Agregar repositorios de software adicional ] [ @Modiﬁcar repositorio

Puede personalizar la seleccion de software ahora o después de la instalacién a través de
la aplicacién de administracion de software.

@ Personalizar mas adelante O Personalizar ahora
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k.

m.

Guardar cambios en disco duro.

Nota: Todos los datos en las particiones a formatear seran destruidos al hacer click en “Escri-
bir cambios al disco”.

Figura 14: Escribir datos en disco

Escribiendo la configuracion de almacenantiento en el ¢

Las opciones de particionamiento que ha seleccionado,
se escribirdn ahora en el disco. Cualquier dato en
particiones borradas o reformateadas se perderdn.

[ Volver Atras ] { Escribir cambios al disco |

Esperar a la copia de los paquetes.

Figura 15: Instalacion en proceso

CentOS6 @

Community ENTerprise Operating System

L ]Paquetes completados: 68 de 199

Instalando MAKEDEV-3.24-6.el6.x86_64 (221 KB)
A program used for creating device files in /dev

Instalacion terminada. Click en reiniciar para completar la instalacion.

Figura 16: Instalacién completada exitosamente

Felicitaciones, la instalacién de su CentOS esta completa.

Por favor, reinicie para usar €l sistema instalado. Note que las
actualizaciones pueden estar disponibles para asegurar el funcionamiento
apropiado de su sistema y su instalacién es recomendada luego de reiniciar.

l {aAtrés ] [aReiniciar]
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n. Ejecucion de CentOS con entrono grafico instalado (gnome).

Figura 17: Ambiente grafico CentOS 6.4

W% Applications Places System @) (o [Z @ @

=

P 3aq &

B. Instalacion y ejecucion del instalador de aplicaciones Synopsys

1. Registrarse en la pagina https://solvnet.synopsys.com usando el correo electronico de la uni-
versidad o sitio. Tomar en cuenta que la autorizacion para el acceso lleva aproximadamente 3
dias. (Synopsys, Synopsys Licensing QuickStart Guide, 2014)

2. Ir a la pagina https://solvnet.synopsys.com/DownloadCenter si es necesario ingresar su usua-
rio y contrasefa.

3.  En My Product Releases elegir Synopsys Installer y descargar la version 3.1 via HTTPS usan-
do el boton Download here. El servidor FTP da varios problemas de conexion, por lo que no
se recomienda usarlo.

4. Leer y aceptar los términos de licencia.

Descargar el archivo installer v3.1l.tar.zZ.

6. Crear una carpeta donde estaran todas las aplicaciones de Synopsys.

9,

# mkdir /usr/synopsys
7. Esrecomendable no realizar el proceso de instalacion como superusuario, para no borrar acci-
dentalmente archivos o carpetas del S.O. Sin embargo, por la ubicacion de la carpeta, si se
requieren permisos de superusuario para crearla, como se puede observar en el comando, de-
bido al prompt #, pero se cambiard de propietario con el siguiente comando. (Synopsys,
Synopsys Licensing QuickStart Guide, 2014)
# chown Electronica /usr/synopsys
Donde “Electronica”, es el nombre de usuario que sera el nuevo propietario de la carpeta.
Después de esto se podra leer y escribir en la carpeta como un usuario normal, con menos
riesgos de cometer algln error que pueda dafiar parte, o completamente la plataforma.
8. Crear una carpeta para alojar los archivos del Synopsys Installer. (notar el cambio de # a $)
$ mkdir /usr/synopsys/installer

9. Mover el archivo installer v3.l.tar.Za/usr/synopsys/installer

$ mv /directorio archivo/installer v3.l.tar.Z
/usr/synopsys/installer/installer v3.1l.tar.Z

10. Descomprimir archivo installer v3.l.tar.Zz.

$ tar xvzf installer v3.l.tar.Z
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11. Dar permisos de ejecucion a los archivos del Installer.
$ chmod -R 755 /usr/synopsys/installer
12. Agregar el directorio del Installer al PATH de Linux.
$ export PATH=S$SPATH:/usr/synopsys/installer

13. Agregar esta ultima linea al archivo SHOME/ .bashrc con el fin de que los comandos del
Installer estén disponibles en la CLI aun si es reiniciado el servidor. Tomar en cuenta que esto
solo va a afectar al usuario que estemos usando, en este ejemplo seria al usuario “Electroni-
ca”.

14. Iniciar el Installer con el comando setup. sh. (No olvidar la extension sh). Se debe iniciar
el entorno grafico del Synopsys Installer.

Figura 18: Pantalla de bienvenida a Synopsys Installer

Synopsys(R) Installer = £3

SYNOPsys'

Copyright® 2013’ Synopsys, Inc.
All rights reserved.

Start >

C. Como instalar aplicaciones con el Installer

Nota: Todas las aplicaciones de Synopsys usan el installer para ser instaladas. (Synopsys, Synopsys
Licensing QuickStart Guide, 2014)

1. Enla pantalla introductoria dar click en Start. Ver Figura 18.
2. Llenar los datos que se solicitan por el asistente, estos datos los posee la persona que represen-
ta al sitio en Synopsys, es decir, la persona que adquirio la licencia.
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Figura 19: Informacion acerca del sitio

Sm;ﬁys(r() Installer

Synopsus(R) Installer SY[I[]PSVS‘

Enter information about your site.

Site ID Nunber: ]

Your site ID number is in the upper-right corner of your Synopsys license key certificate,
If you have trouble locating it, contact your Sunopsys sales representative.

Site Administrator: |

The site administrator is your site's main contact for Sunopsys licensing and other tool
issues, You can leave your own name or type a different name,

Contact Information: Electronica@(none)

Phone number and/or e-mail address of the site administrator,

Elegir la carpeta temporal donde estan los archivos de instalacion common y de la plataforma
de Linux. Estos archivos se descargan en la pagina de SolvNet. En ocasiones no hay un pa-
quete de instalacion de la plataforma Linux, pero la denominada AMD también es compatible
con el CentOS instalado.

Figura 20: Directorio con archivos de instalacion

— Synopsys{R) Installer - X

Sunopsys(R) Installer Synm:\sys‘

Enter the path to the source directory containing the EST (ftp)
or CD/DVD-ROM product files for this version

Click Next to accept the default directory. Alternatively, you can browse for a directory or
type a full path,

Source: [Phone/Electronica | Browse.,.. |

[[<pack | [tet> | [ cancer |

Se debe reconocer la aplicacion a instalar como se muestra en la siguiente figura. Algunas
aplicaciones después de esta pantalla muestran alguna otra informaciéon como otras aplicacio-
nes que se instalaran como dependencia, inicamente es necesario dar click en next si fuera el
caso.
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5.

Figura 21: Confirmacion de la aplicacion a instalar

ynopsys(R) Installer
Sunopsys(R) Installer Synupsys‘
Select a version,
Version Available product(s)
+ 1-2013.12-5P2-1 - hspice
[[<nack | [hexe> | [ cancel |

Elegir la plataforma donde se instalara la aplicacion, recordar que CentOS es un “clon” de
Red Hat.

Figura 22: Confirmacion de la plataforma

| Synopsys(R) Installer - X
Synopsys(R) 1-2013,12-5P2-1 version synupsys‘
Select the platforms on which to install the products,
All platforns may not be available for each product. Check the Installation Guide
or the product version notes for platform availability.
N
W linux - Red Hat Enterprise Linux
A/

[[<pack | [ et > | [ cancer |

Elegir la carpeta de destino, en esta carpeta estaran todos los archivos que la aplicacion a ins-
talar necesita para su ejecucion, esta carpeta es la misma donde se instald el Installer, por
ejemplo: /usr/synopsys/nombre app. Las aplicaciones pueden necesitar de alguna
libreria propia del S.O como dependencia, si se tiene problema con estas dependencias el Ins-
taller no mostrara algln error, el error se mostrara cuando se trate de iniciar la aplicacion, pa-
ra resolver este tipo de problemas use el comando yum whatprovides que mostrara el

paquete que provee la libreria faltante, posteriormente instale este paquete con el comando
yum install “paquete”.



7.

8.

Figura 23: Directorio de instalacién

| Smpsys(R) Installer .

Synopsys(R) 1-2013,12-SP2-1 version Synupsyg

Select the destination directory.

Click Next to accept the default directory. Alternatively, you can brouse for a directory or
type a full path,

Install to:  [Fusr/sunopsus/1-2013.12-5P2-1 | | prosse... |

I‘ < Back | | Next > I | Cancel |

Figura 24: Crear directorio de instalacién

[’

- Create Directo

x

Create destination directory /usr/synopsys/1-2013,12-5P2-17
i Click Yes to create the directory or No to select another

directory,
Yes No |

Figura 25: Verificacion preinstalacion

- X

Synopsys(R) 1-2013,12-5P2-1 version synnpsys-

Yerify the selected information, then click 'Accept, Install' to
begin installation,

[ S;mJEys(R) staller

[N

Product:
HSPICE (hspice,hspicerf,auaves,metaencrypt,converter)
Platform:
common package, linux
Install to:
Zusr/synopsys/1-2013,12-5P2-1
Space required: 2316 MB
Space available: 32930 MB

Kl

Licensed Products communicate with Synopsys servers for the purpose of providing
software updates, detecting software piracy and verifying that customers are using
Licensed Products in conformity with the applicable License Key for such Licensed
Products, Synopsys will use information gathered in connection with this process
to deliver software updates and pursue software pirates and infringers.

If the information is correct, continue with the installation,

[ <pack | [ aooept, mstann | [ cancer |
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Si la carpeta de destino no existe se mostrara un mensaje para aprobar la creacion del directo-
rio, presionar yes.

Verificar que la informacion se la correcta, si hay algin error se puede retroceder y corregirlo.
Cuando todo esté correcto dar click en Accept, Install.



9. Los paquetes se comenzaran a extraer.

Figura 26: Extraccion de paquetes para instalacion

If the information is correct, continue with the installation. |

Extracting hspice_vI-2013,12-5P2-1_common.tar ... | < Back | ] Accept, Install | | Cancel |

10. Esperar a que el proceso de instalacion termine.

Figura 27: Proceso de instalacion

| Synopsys(R) Installer - X

Synopsys(R) 1-2013,12-5P2-1 version Synnpsys‘

Uait while the selected product(s) are installed.

Click Cancel to stop the installation,

Installation progress:

Current action:

Installing platform_independent code for product hspice

Copy ./hspice/GNU/rhel/gcc-4.7,2/1ibexec/gee/x86_64-redhat-1inux/4,7,2/1iblto_plugin,so ...

| Cancel

11. Se muestran algunas notas de post-instalacion, verificar que la instalacion haya sido instalada
con éxito.

Figura 28: Notas post-instalacion

Post-In sfal Igti_oiﬁ_ Note

o Configure log file has been saved as
Zusr/synopsys/1-2013,12-5P2-1/hspice/bin/autoconfig, log

o Do not forget to source cshrc.meta under
/usr/synopsys/1-2013,12-5P2-1/hspice/bin

o HSPICE installing succeeded

Kl

. Dismiss |
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Figura 29: Notas de lanzamiento

[ Release Note - 0O x

Synopsys tools require that a supported version of Synopsys Common
Licensing (SCL) be installed and serving the necessary licenses,
For information on how to obtain SCL, or your license key file,
see http://www,synopsys.com/keys

For any postinstallation setup requirements, see the product-specific
chapters in the Installation Guide at http://www,synopsys,com/install

To receive timely Synopsys support on tool related issues, you must
install YiewConnect support software along with other Synopsys tools,
If you have not yet installed YiewConnect, go to
https://solvnet,synopsys,com/viewconnect#d to download and install the
required binary files,

Kl

' Dismiss I

12. Muestra de la carpeta donde se alojan las aplicaciones de Synopsys.

Figura 30: Muestra de carpeta de instalacion de aplicaciones

[ =] synopsys - File Browser o ([ 3

File Edit View Go Bookmarks Tabs Help
@Back v &) Foward v 4 X = | | &4

Location: l/usr/synopsys jl @ 100% @
=T e [l
[@ Electronica

Desktop 118 CosmosScope CosmosScope64 CustomDesigner

[ File System

= -
ICCompiler

Himagen DesignCompiler HDLCompiler
& Trash

SynopsysFiles [ E}
ynopsys installer PrimeTimeSuite StarRC
(& Documents

& Music
Pictures
Videos
Downloads

&

B
PP

i

11 items, Free space: 32.2 GB

D. Instalacion y ejecucion del servicio de licencia Synopsys Common Li-
censing v 11.8

1. Determinar el HostID que es la direccion MAC de la tarjeta Giga Ethernet conectada a lared
donde se usara el servicio de licencia, esta direccion fue notificada a la empresa Synopsys al
momento de adquirir la licencia por lo que no se puede cambiar, la forma de visualizar esta di-
reccion MAC en Linux es mediante el comando: (Synopsys, Synopsys Licensing QuickStart
Guide, 2014)
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8.

9.

$ ifconfig -a | grep HWaddr
ethO Link encap:Ethernet HWaddr XX:YY:RR:UU:WW:ZZ

Entonces el HostID = XXYYRRUUWWZZ  (sin los )

Ir a la pagina https://solvnet.synopsys.com/DownloadCenter si es necesario ingresar su usua-
rio y contrasefia.

En My Product Releases elegir Synopsys Common Licensing y descargar la version 11.8 via
HTTPS dando click en el botén download now.

Leer y aceptar los términos de licencia.

Descargar el archivo common y el archivo de la plataforma especifica a la distribucion de Li-
nux. Elegir un directorio temporal para la descarga.

Instalar el Synopsys Common Licensing usando el Synopsys Installer como se explica en la
seccion anterior.

Descargar el archivo de licencia ~ mediante la siguiente direccion
https://solvnet.synopsys.com/smartkeys/smartkeys.cgi si fuera necesario ingrese su nombre
de usuario y contrasefia.

Click en Key Retrieval y seleccione el ID de sitio correcto.

Click en continue, en un momento llega el archivo de licencia via correo electronico.

10. Personalizar el archivo de licencia recibido.

a. Elarchivo debe verse como lo siguiente, afladiendo muchas lineas mas.

Cuadro 1: Ejemplo de archivo de licencia

#Server Config: 0000052142

SERVER hostnamel 0128D07E321F 27020

VENDOR snpslmd /path/to/snpslmd

USE_SERVER

INCREMENT SSS snpslmd 1.0 10-dec-2014 1 3EE593F14EED \
VENDOR_STRING="382be a5896 de6l13 1618c 27e26 40bbl 40cec 13318 8da63
128" \

NOTICE="Licensed to ABC Corporation [PLEASE DO NOT DELETE THIS SSS
KEY]" \

SN=RK:0:0:802047 ISSUER="Synopsys Inc." \

START=03-0ct-2005

INCREMENT hspice snpslmd 2013.12 10-dec-2014 8 VENDOR STRING="1+S \
SUPERSEDE ISSUED=06-dec-2013 ck=115 SN=RK:6719-0:733381:117716 \
START=03-0ct-2005 AUTH={ snpslmd=( LK=6D8411D4365F7D1C39DB) \
avantd=( LK=CDE4E1546CD26F379ACB) }

INCREMENT metawaves snpslmd 2013.12 10-dec-2014 8 VENDOR_ STRING="1+S \
SUPERSEDE ISSUED=06-dec-2013 ck=39 SN=RK:6719-0:733381:117716 \
START=03-0ct-2005 AUTH={ snpslmd=( LK=6D3441449638F796655F) \
avantd=( LK=DD44A164467F8C415694) 1}

b. Mover el archivo de licencia a la carpeta recomendada
/usr/synopsys/SCL_Folder/admin/license/license.lic

c. No borrar la linea USE_SERVER, esta debe estar antes de cualquier linea INCRE-
MENT.

d. Abrir el archivo de licencia y verificar que haya solo una linea VENDOR snpslmd
/usr/synopsys/SCL Folder/linux/bin/snpslmd, si existe alguna
otra linea VENDOR o DAEMON es necesario borrarla. La direccion de snpslmd estd en
la carpeta de instalacion de SCL.



23

Todas las lineas deben empezar con SERVER, VENDOR, USE_SERVER, PACKA-
GE, INCREMENT, o #.

Hay lineas que comienzan con el caracter (" \") estas lineas son continuacion de
una linea anterior.

No deben aparecer lineas en blanco ya que pueden causar problemas.

Borrar caracteres extrafios como > 0 >> que en ocasiones son afiadidos en los correos
electronicos.

Obtener el hostname de la PC.

$ hostname
Modificar la linea SERVER.
SERVER hostname hostid tcp port number

En hostname se debe poner el resultado del inciso i. de este paso, en hostid
la MAC address de la tarjeta Giga Ethernet como se mostr6 en el paso 1 de esta sec-
cion, Es muy importante que el hostid coincida con el verdadero hostid de otra mane-
ra se invalidard el archivo de licencia. Por tiltimo en tcp port number, el puerto
TCP que se usara, el puerto por defecto es el 27020, por cuestiones de desempeiio,
los puertos 27000-27009, no son recomendados por Synopsys. A continuacion se
muestra un ejemplo.

SERVER uvgserver XXYYRRUUWWZZ 27020

Guardar los cambios en el archivo de licencia, debe ser un archivo en texto plano, en
el proceso se tuvieron inconvenientes con el editor de texto de CentOS, se modifico
el archivo de licencia con notepad de MS Windows.

Verificar la exactitud del archivo de licencia.

/usr/synopsys/SCL_Folder/Linux/bin/sssverify

/usr/synopsys/SCL_Folder/ admin/license/license.lic

Asegurarse de que la verificacion sea exitosa, de no ser asi existen problemas en
el formato del archivo de licencia.

11. Verificar que no haya ninglin servicio levantado que use nuestro archivo de licencia.

lmdown -c /usr/synopsys/11.8/admin/license/license.lic

12. Iniciar el servidor de licencias SCL.

Ilmgrd -c /usr/synopsys/11.8/admin/license/license.lic

El log obtenido debe ser algo parecido al siguiente. (Se han omitido algunas lineas por
brevedad)
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Cuadro 2: Log de inicializacion de servidor de licencias

11:

11

11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:
11:

11

11:
11:
11:
11:

11

11:
11:

146690 186 1sb)

18:
:18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
18:
:18:
18:
18:
18:
18:
:18:
18:
18:
[Electronica@scluvg license]$ 11:18:10 (lmgrd) FlexNet Licensing (v11.12.1.0 build
started on scluvg (linux) (8/20/2014)

10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10
10

11:18:10
11:18:10
11:18:10

/usr/synopsys/11.
11:
11:
11:

11

11:
11:
build
11:

11

11:
11:
11:
11:
11:
11:

18:
18:
18:
:18:
18:
18:

18:
:18:
18:
18:
18:
18:
18:
18:

10
10
10
10
10
10

146690

10
10
10
10
10
10
10
10

Please Note:

This log is intended for debug purposes only.

In order to capture accurate license

usage data into an organized repository,

please enable report logging. Use Flexera Software LLC's
software license administration solution,

FlexNet Manager, to readily gain visibility

into license usage data and to create

insightful reports on critical information like
license availability and usage. FlexNet Manager
can be fully automated to run these reports on
schedule and can be used to track license

servers and usage across a heterogeneous

network of servers including Windows NT, Linux

and UNIX. Contact Flexera Software LLC at
www.flexerasoftware.com for more details on how to
obtain an evaluation copy of FlexNet Manager

for your enterprise.

Server's System Date and Time: Wed Aug 20 2014 11:18:10 CST
SLOG: Summary LOG statistics is enabled.

Copyright (c) 1988-2014 Flexera Software LLC. All Rights Reserved.
World Wide Web: http://www.flexerasoftware.com

(lmgrd) License file(s):

8/admin/license/Synopsys Key Site 31759 Server 249913 snpslmd.txt
lmgrd tcp-port 27020
(@lmgrd-SLOGE)
(@lmgrd-SLOGR@) === LMGRD ===
(@1lmgrd-SLOGE@) Start-Date: Wed Aug 20 2014 11:18:10 CST
(@lmgrd-SLOG@) PID: 3355

(@1lmgrd-SLOGR@) LMGRD Version: v11.12.1.0 build 146690 186 1lsb

(ipv6))

(@lmgrd-SLOGR)
(@lmgrd-SLOGR) === Network Info ===
(@1lmgrd-SLOGE@) Socket interface: IPV6
(@lmgrd-SLOGR@) Listening port: 27020
(@1lmgrd-SLOGR)
(@1lmgrd-SLOGE@) === Startup Info ===
(@lmgrd-SLOGR@) Server Configuration: Single Server
(@lmgrd-SLOGE) Command-line options wused at LS startup:

/usr/synopsys/11.8/admin/license/Synopsys Key Site 31759 Server 249913 snpslmd.txt
11:18:10
used:
Ltxt

11:18:
11:18:
11:18:
11:18:

10
10
10
10

SCL_11.8

11:
11:

11

11:
11:

18:
18:
:18:
18:
18:

33
33
33
33
33

(lmgrd) (@1lmgrd-SLOGR) License file(s)
/usr/synopsys/11.8/admin/license/Synopsys Key Site 31759 Server 249913 snpslmd

(@lmgrd-SLOGR)
Starting vendor daemons
Started snpslmd (internet tcp port 36769 pid 3356)

(snpslmd) FlexNet Licensing version v11.12.1.0 build 146690 186 1sb
08/20/2014 11:18:10 (snpslmd) Synopsys Corporate Licensing (SCL) Release: version

snpslmd) SLOG: Summary LOG statistics is enabled.
snpslmd) SLOG: FNPLS-INTERNAL-CKPT1

snpslmd) SLOG: VM Status: O

snpslmd) SLOG: FNPLS-INTERNAL-CKPT2

snpslmd) Server started on scluvg for: SSS
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Continuacion de Cuadro 2.

11:

11
11

11:

11

11:

11:

18:33 (snpslmd) ACS ADP_OA AN-Impl3D all

:18:33 (snpslmd) AdvTelecomLib simulation BASIC_ANALYSES BATCH_MEASURE

:18:33 (snpslmd) BATT_ TOOL BLHandler_ sbl_amba2 BLHandler sbl amba3 axi

18:33 (snpslmd) COSMOS_SCOPE COSMOS_VO CPI-100

:18:33 (snpslmd) HDL-Compiler HERCULES-CRYPT XREF DATA HERCULES-DP_MT

18:33 (snpslmd) HERCULES-EXPLORER DRC HERCULES-EXPLORER FILTERS HERCULES-

EXPLORER LVS
18:33 (snpslmd) HERCULES-NETLIST HERCULES-RUN_ TRAN HERCULES DEBUGGER

11:18:33 (snpslmd) HSPICE MODEL LIBRARY ICValidator2-CompareEngine ICValidator2-
GeometryEngine

11:18:33 (snpslmd) VHDL-Analyzer VHDL-Compiler VHDL-Cycle-Sim

11:18:33 (snpslmd) VHDL-Elaborator VHDL-Event-Sim VHDL-Tools

11:18:33 (snpslmd) VHDL-VirSim VIEWLOGIC_FRAMEWAY VIEWLOGIC_NET

11:18:33 (snpslmd) VIP-LIBRARY-SVT VIP-PROTOCOL-ANALYZER VSDK.primary

11:18:33 (snpslmd) VSDK.simulation VT_Assertions VT_AssertionsRuntime

11:18:33 (snpslmd) VT Coverage VT CoverageRuntime VT CoverageURG

11:18:33 (snpslmd) VT_CoverageURG VT Testbench VT_TestbenchRuntime

11:18:33 (snpslmd) VT _VCS NATIVE LP VT VCS NLP SIGNALS VT Visual

11:18:33 (snpslmd) Verdi VerdiCoverage WE_API

11:18:33 (snpslmd) WE_API_ HSPICE WE_API_STARSIM XVCSDebugger

11:18:33 (snpslmd) hspice hspice3des hspicecmidev

11:18:33 (snpslmd) hspicecmirt hspicerf identdebugger cert

11:18:33 (snpslmd) sx cdslink ext sx _daiclink sx_data

11:18:33 (snpslmd) sx jedatlink synopsys_designware tlm lib synphony

11:18:33 (snpslmd) synphony batch synphony cout synphony coutsl

11:18:33 (snpslmd) synphony ipgen asic synphony ipgen fpga synphony msynth

11:18:33 (snpslmd) synphony sacout synplifydsp asic synplifydspsl

11:18:33 (snpslmd) synplifypremierdp vera comp vera debug

11:18:33 (snpslmd) vera rtime xsim

11:18:33 (snpslmd)

11:18:33 (snpslmd) Licenses are case sensitive for TE_CATS

11:18:33 (snpslmd)

11:18:33 (snpslmd) EXTERNAL FILTERS are OFF

11:18:33 (lmgrd) snpslmd using TCP-port 36769

11:18:33 (snpslmd) Serving features for the following vendor names:

snpslmd ACAD adalmd anagram arcd archprod avantd CADABRA chrysa-
lisd cowared EPIC eved everest extremed hscd innologd ISE-
TCADd knights 1la dmon leda magma metasoftd mwflexd nassd nsysnvs numer-—
itchd pdld perflmd riod saber dmn sandwork sclmgrd sig-

macd slat snpsOEM1 snpsOEM2 snpsOEM3 snpsOEM4 snslmgrd ssilmd syn-
forad synopsysd synplctyd TAVEREN TE CATS tmald vastlmd vcsd

08/20/2014 11:18:34 (snpslmd) ———————————— -

08/20/2014 11:18:34 (snpslmd) Checking the integrity of the license file...
08/20/2014 11:18:34 (snpslmd) Valid SSS feature found.
08/20/2014 11:18:34 (snpslmd) The feature is needed to enable the other keys in your

license file.

08/20/2014 11:18:34 (snpslmd) Licensed to Universidad del Valle de Guatemala
08/20/2014 11:18:34 (snpslmd) Siteid: 31759, Server Hostid: 180373237BDF, Issued on:

7/16/2014

08/20/2014 11:18:34 (snpslmd) ———————————— -

11:
11:
11:
11:
11:
11:
11:
11:
11:

11: (

11: (

11: (

:18:34 (snpslmd) (@snpslmd-SLOGE@) Is vendor daemon a CVD: Yes
(
(
(

11

11:
11:
11:

18:34 (snpslmd) SLOG: Statistics Log Frequency is 240 minute(s) .

18:34 (snpslmd) SLOG: TS update poll interval is not set.

18:34 (snpslmd) SLOG: Activation borrow reclaim percentage is 0.

18:34 (snpslmd) (@snpslmd-SLOGE)

18:34 (snpslmd) (@snpslmd-SLOGE@) === Vendor Daemon ===

18:34 (snpslmd) (@snpslmd-SLOGE@) Vendor daemon: snpslmd

18:34 (snpslmd) (@snpslmd-SLOGE@) Start-Date: Wed Aug 20 2014 11:18:34 CST

18:34 (snpslmd) (@snpslmd-SLOGE@) PID: 3356

18:34 (snpslmd) (@snpslmd-SLOGE@) VD Version: v11.12.1.0 build 146690 186 1sb (

build 146690 (ipv6))

18:34 (snpslmd) (@snpslmd-SLOGR)
18:34 (snpslmd) (@snpslmd-SLOG@) === Startup/Restart Info ===
18:34 (snpslmd) (@snpslmd-SLOGE@) Options file used: None

18:34 (snpslmd) (@snpslmd-SLOGE@) Is TS accessed: No
18:34 (snpslmd) (@snpslmd-SLOGE@) TS accessed for feature load: -NA-
18:34 (snpslmd) (@snpslmd-SLOGE@) Number of VD restarts since LS startup: 0
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Continuacion de Cuadro 2.

+11:18:34 (snpslmd) (@snpslmd-SLOGE)

11:18:34 (snpslmd) (@snpslmd-SLOG@) === Network Info ===

11:18:34 (snpslmd) (@snpslmd-SLOGE@) Socket interface: IPV6

11:18:34 (snpslmd) (@snpslmd-SLOGE@) Listening port: 36769

11:18:34 (snpslmd) (@snpslmd-SLOGE@) Daemon select timeout (in seconds): 1
11:18:34 (snpslmd) (@snpslmd-SLOGE)

11:18:34 (snpslmd) (@snpslmd-SLOG@) === Host Info ===

11:18:34 (snpslmd) (@snpslmd-SLOGE@) Host used in license file: scluvg
11:18:34 (snpslmd) (@snpslmd-SLOGE@) Running on Hypervisor: None (Physical)
11:18:34 (snpslmd) (@snpslmd-SLOGE@) LMBIND needed: No

11:18:34 (snpslmd) (@snpslmd-SLOG@) LMBIND port: -NA-

11:18:34 (snpslmd) (@snpslmd-SLOGE)

E. Agregar la direccion del servidor de licencias a un usuario final

1. En CentOS. Para agregar la direccion del servidor de liciencias en CentOS, en el archivo
SHOME/ .bashrc agregar la siguiente linea.

LM LICENSE FILE=tcp port@hostname; export LM LICENSE FILE

Con tcp_port 'y hostname el puerto TCP y el nombre de host que se configur6 en el archivo de licencia
con anterioridad. Si hay algin problema resolviendo el nombre del host del servidor se puede remplazar
con la direccion IP del mismo. (Synopsys, Synopsys Licensing QuickStart Guide, 2014)

2. En MS Windows. Agregar la variable de entorno como se muestra en la siguiente figura:

Figura 31: Variable de entorno a servidor de licencias

Propiedades del sistema

Nombre de equipo Hardware

Variables de entorno

B3

Editar la variable del sistema

Nombre de la variable: LM_LICENSE_FILE

Valor de la variable: [ 27020@hostname]

Variables del sistema

Variable Valor "~
installdir C:\synopsys'Hspice_A-2008.03
installdir_A-200... C:\synopsys\Hspice_A-2008.03
LM_LICENSE_FILE ~C:\Flexim\Hspice_2007-09.lic

NUMBER_OF P... 2 b

Nueva... Editar... Eliminar

Aceptar Cancelar

Si hay algtin problema resolviendo el nombre del host del servidor se puede remplazar con la direccion
IP del mismo.
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F. Aplicaciones a instalar para el correcto uso del ambiente de di-

sefo.
1. Galaxy Custom Designer (instalar con Synopsys Installer).
2. 1PDKs y librerias. (Ver la seccion 4.8).
3. IC Validator. (instalar con Synopsys Installer).
4. Hspice. (instalar con Synopsys Installer).
5. StarRC. (instalar con Synopsys Installer).
6. Custom Explorer. (instalar con Synopsys Installer).
7. PyCell Studio. (Ver el siguiente cuadro). (Synopsys, PyCell Studio, 2014)

Cuadro 3: Instalacion de PyCell Studio

o a

=

Ir a la pagina:
https://www.synopsys.com/TOOLS/IMPLEMENTATION/CUSTOMIMPLEMENTATION
[Pages/pycell-studio.aspx y hacer click en download now.
Llenar los campos solicitados.
Mediante el correo electrénico registrado llegara un link de descarga, un usuario y una con-
trasefia. Descargar el paquete.
Descomprimir el paquete en algiin directorio temporal.
En la linea de comando navegar hasta el directorio temporal y ejecutar el comando:
./installer

Elegir un directorio para la instalacion, por ejemplo: /usr/synopsys/PyCell
Agregar las variables de entorno necesarias con el comando.

$ source /usr/synopsys/PyCell/quickstart/bashrc
Agregar el comando anterior al archive SHOME/.bashrc.
Verificar la instalacion.

$ cd SCNI ROOT/quickstart

$ pyros

En el programa abierto

= TIr al menu: File > Open Design

* Library: IPL cnil30

= Cell: FastNmos

= View: layout

= Click Ok.
En el panel de parametros cambiar wf a 2.0 y hacer click en aplicar, se debe observar un
cambio en la celda, esto nos asegura una instalacion de PyCell Studio correcta.
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G. Edicion del archivo $SHOME/.bashrc

Este es un archivo muy importante para la configuracion inicial de nuestro ambiente de trabajo, en este
archivo se agregan comandos importantes para que se agreguen las correctas variables de entorno al siste-
ma operativo al inicio del mismo, estas variables son de extrema importancia para que las distintas aplica-
ciones se comuniquen entre si, como se vera mas adelante nuestra aplicacion principal es Galaxy Custom
Designer que es una plataforma unificada y necesita estas variables para poder funcionar correctamente. A
continuacion se presenta el archivo SHOME / . bashrc base, con el cual se han probado las aplicaciones,
antes de usar las aplicaciones debe asegurarse que su archivo .bashzrc esté en dptimas condiciones, el
que se presenta es una base, este archivo se usa para muchas configuraciones, acé se muestra la configura-

cion para el fin de este trabajo.

Cuadro 4: Archivo SHOME/.bashrc

# .bashrc

# Source global definitions

if [ -f /etc/bashrc ]; then
/etc/bashrc

fi

# User specific aliases and functions
# Se agrega la direccién del servidor de licencias

LM LICENSE_FILE=27020@scluvg; export LM LICENSE_FILE

# Variable para iPDK de Synopsys

export SAED32 28 PDK=/usr/synopsys/iPDK/SAED32_ 28 iPDK/
# Variable para IC Validator

export ICV_HOME DIR=/usr/synopsys/IC_Validator

# Directorio de IC Validator
PATH=/usr/synopsys/IC_Validator/bin/AMD. 64:$PATH
export PATH

#Generacidén de variables para PyCell Studio
source /usr/synopsys/PyCell/quickstart/bashrc
#Directorio del servidor de licencias
PATH=/usr/synopsys/11.8/1linux/bin:$PATH

export PATH

#Directorio de Hspice
PATH=/usr/synopsys/HSPICE/I-2013.12-SP2-1/hspice/bin/: $PATH
export PATH

#Directorio de StarRC
PATH=/usr/synopsys/StarRC/bin/: $PATH

export PATH

# Directorio de CustomDesigner
PATH=/usr/synopsys/CustomDesigner/bin/: $PATH
export PATH

#Directorio de CustomExplorer
PATH=/usr/synopsys/CustomExplorer/bin/: $PATH
export PATH
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H. Galaxy Custom Designer

Es una aplicacion de Synopsys que provee una solucion unificada para el disefio personalizado o basa-
do en celdas de los layouts de un circuito en VLSI, Custom Designer provee la capacidad de simulacion,
analisis, extraccion de capacitancias parasitas y la verificacion fisica. Es importante mencionar que soporta
el uso de kits de disefio de proceso interoperable (iPDK) que son paquetes que proveen las empresas dedi-
cadas a hacer el proceso de fundicion (foundry) donde estan sus reglas de disefio, mecanismos para compa-
rar el layout final con el diagrama esquematico y su forma de extraer parasitos. Synopsys, en su plan de
capacitacion universitaria provee un muy util PDK, que puede ser usado para investigacion, experimenta-
cién y capacitacion, aunque no recomiendan usarlo para la fabricacion final. Este PDK esta avalado por la
TSMC que le da un peso significante a la libreria para usarla como medio de aprendizaje. Estas caracteris-
ticas aumentan la productividad en cualquier ambito en el que se use Galaxy Custom Designer. (Synopsys,
Custom Designer, 2014)

1. Instalacion del iPDK

a. Ir a la pagina http://www.synopsys.com/apps/protected/university/members.html que
ofrece informacion a las instituciones educativas asociadas con Synopsys, también ma-
terial de estudio y experimentacion, entre ellos las librerias que se usaran para el disefio
del sumador restador. (Synopsys, 32/28nm Interoperable PDK, 2014)

b. En la seccion de Libraries descargar las librerias que se quieran usar. En este caso se
usaron las de 32 a 28 nandémetros usando el enlace 32/28nm Generic Library Down-
load.

c. Después de llenar una pequefia encuesta para estadisticas de Synopsys y aceptar los
términos de licencia se tiene acceso a la descarga de los paquetes.

d. Conforme a la experiencia se recomienda descargar los paquetes desde el servidor de
licencias usando la linea de comandos como lo muestran las instrucciones en la si-
guiente tabla, esto debido a que usando la interfaz web se tiende a rechazar la conexion
al servidor FTP o a terminar las descargar antes de ser completadas.

e. Descargar todos los archivos de la lista.

Cuadro 5: Descarga desde servidor FTP

1) Iniciar session en "ftp.synopsys.com" eg.
$ ftp ftp.synopsys.com
2) Ingresar usuario y contrasefia de SolvNet.
3) Si no estd en modo pasivo ingrese usando el commando
"passive".
4) Ingrese "binary" en el ftp prompt para establecer el mo-
do de transferencia a binario. ftp> binary
5) ftp> hash (opcional, muestra # en proceso de descarga) .
6) ftp> cd cafe
7) ftp> cd 32-28nm EDK 07292013
8) ftp> Escriba "1ls" o "dir" para ver la lista de archivos.
9) ftp> get + nombre de archivo.

Si no es posible conectarse con el servidor ftp puede usar algunos de
los alternativos segun la ubicacion geografica.

e US - marley.synopsys.com (198.182.44.204)
e FEurope - tosh.synopsys.com (149.117.30.1) o fire-
ball.synopsys.com(198.182.37.221)

® Asia - huOlestftp.synopsys.com (84.2.38.58)
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Descargar el iPDK en la seccion “iPDKs” de la misma forma.
Descomprimir todos los paquetes obtenidos en alguna carpeta, por ejemplo en
/usr/synopsys/1iPDK la siguiente figura mostrara el resultado final.

Figura 32: Directorio de iPDK de Synopsys

1. |/usr/synopsys/iPDK

:" S, 100% ©, |lcon View o}

ol = = = [ = [

SAED32_28_iPDK SAED32_EDK_ SAED32_EDK_ SAED32_EDK_ SAED32_EDK_IO SAED32_EDK PLL  SAED32_EDK_REF

CORE_HVT CORE_LVT CORE_RVT

= =

SAED32_EDK_SRAM  SAED32_EDK_TECH

La carpeta iPDK contiene todos los archivos sobre la tecnologia de las librerias,
modelos de Hspice, archivos de mapeo, reglas de disefio y archivos para la evaluacion
fisica del disefio y también para extraccion de parasitos de un layout. Para que Custom
Designer reconozca esta libreria es necesario instalarla en nuestro SO.

Agregar la variable de entorno
export SAED32 28 PDK=/usr/synopsys/iPDK/SAED32 28 iPDK/
Nota: La direccion $SAED32 28 PDK debe ser una direccion valida.

Copiar los archivos de /usr/synopsys/iPDK/SAED32 28 iPDK/install a
la $HOME .

En este punto ya se puede iniciar el Custom Designer en algin folder que se use como
“folder de trabajo”, puede iniciarse desde cualquier ubicacidn, sin embargo, se reco-
mienda usar un sélo folder ya que la cantidad de archivos generados es grande y es me-
jor tenerlos en una Unica ubicacion. Navegar desde la linea de comandos hasta el folder
de trabajo y ejecutar el siguiente comando el cual mostrara una ventana (consola de
Custom Desgner) similar a la de la Figura 33.

$ cdesigner &

Figura 33: Custom designer console

[Eo] 0 Custom Designer Console EWEIC
File Edit View Tools Options Window Help SYynopsys
= (= a
@B e|B|sm
=
Warning: Cannot ope=n log file '/homs/El=ctronica/Desktop/Foldsr_d=_Trab
Information: Application log is redirscted to file '/homs/Elsctronica/D:
Warning: Cannot open log file= '/homs/El=ctronica/Desktop/Foldsr_d=_Trab.
=N Information: Application log is redirected to file '/home/Electronica/D:
@o FRRRERRRRRREAFRRRERRRRREIIRRREERRRE
jS) PDK Nams : SAED_PDK32_28
= PDK Release Date : 07-04-2014
s PDK C H-2013.06

Kl

| o

output | History | ErrorsiWarnings |

Designer> ||
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Y al abrir el Library manager deben aparecer nuestras librerias, en este punto so-
lo aparecera la SAED PDK 32 28.(Synopsys, 32/28nm Interoperable PDK, 2014)

Figura 34: Custom designer library manager

i 1 Custom Designer Library Manage
File Edit Window Help

| b |eBr|®ee x|
[¥ Show Cell Categories

I I I

Libraries /| | cell categorii / | Cells

= EDK

B EDK_LVT_32-28nm
5 Full_Adder_32bits
5 Full_Adder_32bits_BK
5 rFull_Adder_32bits_...
5 SAED32_EDK_IO

B SAED_PDK_32

B SAED_PDK_32_28
& analogLib

5 basic

5 reference

5 sample

5 sheets

& snpsDefTechLib

k. Para agregar las librerias descargadas primero se crea una libreria donde se alojaran los
datos nuevos, agregando a esta nueva libreria la libreria SAED PDK 32 2§.

Figura 35: Agregar una libreria nueva

i New Library x

—Attributes

Name: | NOMBRE DE LA NUEVA LIBRERIA
Directory: [/ @I
Type: ¢ FileSys ¢ Turbo ¢ ICC  Ref Libs... '

—Technology

¢ None

 Import File | _—I

& Attach [ saED_PDK_32 |

¢ Reference | 2K

I~ Enable Pcell Caching

Cache Directory: |ectronica/Desktop/FoIder_de_Trabajo _—,‘I

-I~ Enable Parameter Overlay

Overlay Directory; Ictronica/Desktop/FoIder_de_Trabajo (=] I

Help | Defaults H OK I Apply | Cancel |
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1. Enla consola de Custom Designer
File>Import>{stream | LEF | Netlist}
o Stream es para agregar layouts, mediante un archivo extension gds.
e LEF para agregar un abstract que es una parte del layout, mediante un archivo
extension lef.
e  Netlists para agregar archivos de texto con la definicion de decks.
o CDL agrega decks.
o HSPICE agrega decks con extraccion de parasitos.
o VERILOG agrega un archivo que describe algiin circuito.
m. La libreria de destino sera la libreria que se cred en el paso 11. Hasta este punto tene-
mos todo configurado para empezar con las fases de disefio de nuestro circuito.

2. Fases de diseno

a. Realizacién de circuito esquemadtico. El disefio comienza al nivel de conexion de los di-
ferentes componentes en un diagrama esquematico, cada componente debe tener sus propiedades bien edi-
tadas para que las siguientes fases muestren resultados fiables. Un diagrama esquematico es la conexion de
los componentes con sus propiedades fisicas correctas. Después de tener un disefio esquematico terminado
se puede crear un netlist para la simulacion y evaluacion del desempefio, cuando el desempefio es correcto
se puede proceder a la realizacion del layout. (Synopsys, Custom Designer, 2014)

El editor esquematico es muy pa recido a los programas que se usan para la simulacién de circuitos,
tiene las caracteristicas de orientacion (o transformacion) que gira o refleja los componentes para hacer mas
entendible el diagrama. También esta el modo Infix, que facilita la edicion de los elementos cuando se usa
algin comando, cuando se usa este modo se realiza un click implicito que su funcidon depende del comando
que se use. Por ejemplo puede ser un punto de referencia para dibujar un rectangulo o un segmento de li-
nea, o el eje de rotacion de algin elemento.

Lo primero que se debe hacer, al momento de empezar a usar el editor esquematico es elegir nuestras
preferencias en el programa, qué se quiere visualizar y qué no, establecer las opciones de disefio que son
puntos como espaciado entre elementos, grosores de cables, prefijos de los nombres de las rutas etc. Todo
esto se hace desde el meni Options>{Display | Design | General}. Algo que es muy recomendable es
editar la visualizacién de las etiquetas que se mostraran, esto se hace en Edit>properties>Manage Labels.
Después de poner a punto el programa donde se estard trabajando se puede proceder a la creacion del es-
quematico. Algunos conceptos se explican a continuacion.

Una instancia es una representacion de un disefio o de un objeto dentro de otro disefio, se pueden tener
varias instancias de un mismo disefio u objeto, pero deben tener diferentes nombres. Para agregar una ins-
tancia vaya a Add>Instance y elija las opciones y los parametros de la instancia, luego en el area de traba-
jo elija el lugar donde colocar la instancia. Después de estas acciones la instancia estara colocada en el
lienzo de trabajo, tome encuentra que el comando sigue activo para agregar una instancia igual, puede salir
del comando con la tecla Esc.

El agregar conexiones fisicas (alambres) entre los dispositivos es una tarea trivial, sin embargo, hay
que tomar en cuenta que para Custom Designer todas las rutas tienen un nombre para ser identificadas, sera
una tarea especifica cuando se cambie este nombre, por lo general se deja el nombre agregado por defecto.

Para agregar un alambre Add>Wire, seguidamente especificar la opciones de la conexion y elegir el
punto de inicio y fin.

Para un disefio mas ordenado y mas profesional se recomienda realizar bloques, al estilo de las conoci-
das cajas negras, donde se tengan entradas y salidas, conocer la funcion que los relaciona pero no forzosa-
mente tener que saber qué hay dentro, esta es una buena técnica para reciclar trabajos antiguos. Las entra-
das y salidas se hacen mediante pines que se agregan en Add>Pin, luego especificar las opciones y para-
metros del pin y agregarlo en alguna parte del lienzo de trabajo.
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Cuando se han agregado las librerias a Custom Designer, se muestra cada una de ellas en el Library
Manager, la iPDK instalada posee una gran cantidad de compuertas y componentes comunes como suma-
dores, sumadores completos, flip-flops, multiplexores, etc. Cada uno viene con un deck para simulaciones
(CDL), un deck para simulaciones tomando en cuenta parasitos (Hspice), /ayout y un archivo de descrip-
cion de hardware en Verilog. Algo que se omite es la agregacion de un esquematico, aunque no es critico
tenerlo ya que con los decks se puede simular y caracterizar al circuito, se mostrara a fin de ejemplo como
se desarrolla una caja negra para un sumador completo de 1 bit a nivel de diagrama esquematico. Esta caja
negra es una copia idéntica del circuito descrito en el netlist CDL. (Synopsys, Custom Designer, 2014)

Figura 36: iPDK agregado a Custom Designer

i 1 Custom Designer Library Manager T3¢
File Edit Window Help
|b8|cBr|ee x|

¥ Show Cell Categories [~ Open Read-Only
| [ |FADD |
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B Full_Adder_32... config

& Full_Adder_32... hspice

5 rull_Adder_32... layout
5 SAED32_EDK_IO emat
[ SAED_PDK_32

(=] K verilog

& analogLib

=

5 reference

& sample

& sheets Preview

5 snpsDefTechLib Directory: jusr/syn...

Modified: 2014-10...
Owner: Electronic...
Group: Electronic...
Other: (R/W/E)

Lo primero que se hace es ubicar y seleccionar la libreria en el Library Manager, seleccionar la catego-
ria a la que pertenece nuestra celda, seleccionar la celda. Hacer click derecho en el espacio de views y se-
leccionar nuevo. Aparecera la siguiente pantalla.

Figura 37: Elaboracion de la vista Schematic
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View Name: |

Editor: | |~
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_p‘ Hierarchy Editor el | |

4
Layout Editor z
Netlist Editor

Schematic Editor

Symbol Editor
Text Editor (CDLText)
Text Editor (SPICEText) -
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En editor elegir Schematic Editor, asegurarse que la libreria, la categoria y que la celda sean las correc-
tas y hacer click en OK. Inmediatamente se abrira el editor esquematico en el cual se deben agregar los
transistores que se indican en el CDL y conectarlos entre si. En circuitos con muchos transistores es reco-
mendable usar etiquetas y no conectar mediante wires cada una de las instancias, se podria volver muy
complejo.

Figura 38: Interconexién de instancias
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Seguidamente se crea un simbolo, una caja negra que representard al sumador en cualquier otro lienzo
de trabajo en el que se agregue su instancia. Para el efecto se agrega una nueva vista, de la misma forma
que se agrego la vista del esquematico con la diferencia que se selecciona Symbol Editor. Automaticamente
se abre el editor correspondiente y una proposicion de simbolo por parte de Custom Designer, se puede
cambiar de tamafio, cambiar el lugar de los pines al gusto del disefiador.

b.  Simulacion. Una vez que ya se tiene el esquematico y el simbolo agregado a la vista de
nuestra celda es necesario saber si funciona correctamente. Recordar que el simbolo hace referencia al
conjunto de transistores que componen el circuito y es una forma compacta de verlo, si hay algo no espera-
do en los resultados de simulacion el problema estara en los transistores y no en el simbolo a menos que sea
un problema que falte algin pin, se debe actualizar el simbolo. (Synopsys, Custom Designer, 2014)

La forma correcta de hacer una simulacion es hacer otra celda para el testbench, esto porque no se pue-
de instanciar una celda dentro de si misma. Se muestra un ejemplo en la siguiente figura.
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Figura 39: Celda para testbench
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Resta explicar qué contendra entonces las vistas schematic y config de esta celda para testbench. En la
vista de esquematico se agrega el simbolo anterior con fuentes de alimentacion, fuentes de pulsos, resis-
tencias y todo lo demas que se necesite para poder inyectar al circuito las sefiales necesarias para compro-

bar su funcionamiento.

Figura 40: Esquematico para realizacion de pruebas
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El siguiente paso es ir a Tools>Hierarchy Editor se abrira la ventana del editor de jerarquia que es un
orden el cual tomara el simulador en cuanto a la vista que tomara para hacer la simulacion. Como primer
verificacion se asegurara que la libreria, la celda y la vista sean las que se quieren configurar. (Synopsys,
Custom Designer, 2014)

Figura 41: Configuracién de la busqueda jerarquica entre vistas 1

# 8 Full_Adder_32bits/FullAdder_1bit_tb/config - Custom Designer Hierarchy Editor 21
File Edit View Window Help

IEEEITEEEIEEEEE
Top Cellview
Library: IFuI]_Adder_32bits LI cell: IFuIIAdder_lbit_tb j View: Ischematic LI Bl EI

View Search List: |hspice hspiceD cmos.sch cmos_sch schematic veriloga

View Stop List: |hspice hspiceD veriloga

Library Search List: |

Instance /2 ]Bound Selected View Search List
= Full_Adder_32bits/Fulladder_1bit_tb schematic
10(EDK, FADDX1_RVT) hspice hspice hspiceD crr
V2(analogLib, vsource) hspice hspice hspiceD cm
V3(analogLib, vpulse) hspice hspice hspiceD crr
V4(analogLib, vpulse) hspice hspice hspiceD cm
V5(analogLib, vpulse) hspice hspice hspiceD cmr

En el apartado View Search List se deben agregar las listas en el orden que el simulador las buscara pa-
ra hacer la labor. En la figura anterior es <hspice hspiceD cmos.sch cmos_sch schematic veriloga> y en
View Stop List que es donde se parara de buscar <hspice hspiceD veriloga>. Se pueden ver los resultados
de las vistas que el simulador usara en la parte de abajo, en la columna Bound se puede ver en este ejemplo
que el simulador usara el netlist con parasitos de Hspice, si se desea usar la vista del esquematico basta con
colocar la palabra Schematic de primer lugar en la jerarquia de buisqueda.

Figura 42: Configuracién de la bisqueda jerarquica entre vistas 2

8 Full_Adder_32bits/FullAdder_1bit_tb/config - Custom Designer Hierarchy Editor
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La figura muestra el cambio mencionado, notar que las fuentes de alimentacion y excitacion del circui-
to siguen usando a Hspice para hacer la simulacion, esto es asi normalmente para las fuentes de tension ya
que no hay un esquematico en las librerias instaladas que definan su funcionamiento. Al guardar estos
cambios se crea la vista config que es basicamente eso, configuracion del netlist que se usara para la simu-
lacion. Se procede a abrir el esquematico del testbench, ir a: Tools>SAE. (Simulation Analysis Envi-
roment). En la ventada de SAE lo primero que se hace es configurar la simulacion en el menu Setup.

Cuadro 6: Configuraciéon de SAE

Ment Configuraciones
Setup>Design Verificar la libreria, celda y vista (config) que se desea
simular.
Setup>Simulator Se elige el motor de simulacion que se usara. Normalmen-

te se elige Hspice.

Setup>Enviroment Option | Se configura el entorno en que se hara la simulacion, nor-
malmente no hay que modificar nada, pero si se tiene al-
gun problema con que no se encuentra el simulador elegi-
do intentar deseleccionar la opcion de simulaciéon en 64-
bits.

Setup>Analyses Seleccionar los tipos de analisis que se desean realizar
durante la simulacion, por ejemplo: Analisis en el tiempo,
puntos de operacion, DC etc. Se puede elegir uno o mas a
la vez.

Setup>Model Files Es quiza la mas importante de las configuraciones. En esta
seccion se agregan los archivos que contienen los modelos
para la simulacion. Sin estos modelos la simulacion no se
puede llevar a cabo. El archivo de modelos de la tecnolo-
gia usada se encuentra en el directorio de instalacion de la
libreria. En este caso se encuentra en:
/usr/synopsys/iPDK/SAED32 28 iPDK/hspice.
Primero se debe agregar el directorio en Include Path 'y
luego el archivo en si en la seccion Model File también es
necesario especificar la seccion del modelo que se va usar,
un archivo de modelos normalmente las secciones TT, FF
etc. Que sirven para especificar de mejor forma el transis-
tor que se va a usar.

Output>Select in Design Se abre el esquematico del testbench y mediante un click
se selecciona la sefial que se desea analizar. Cuando se
termine de seleccionar las sefales deseadas presionar la

tecla Esc.
Simulation>Netlist and | Se crea el deck y empieza Hspice (o el simulador elegido)
run a adquirir los datos para mostrar los resultados, cuando

termina se abre WaveView y se muestran las graficas, esto
en caso de haber selecciona una analisis transiente (que es
el tipo de analisis mas comin).
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Figura 43: Resultados de simulacién
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c. Andlisis. La etapa de analisis es una etapa donde se debe verificar que los datos obtenidos
son los esperados, en este punto es necesario estar seguros que todo funciona correctamente, que los niveles
de voltaje en salidas y entradas son correctos etc. No es necesario en esta etapa analizar tanto en aspectos
como potencia, energia, tiempo o alguna otra variable muy especifica ya que en este punto no se tiene un
circuito final porque faltan los parasitos que generara el Layout. (Synopsys, Custom WaveView™, 2014).

Existen varias aplicaciones para analizar los datos obtenidos como Custom WaveView, Custom Explo-
rer, Custom Explorer Ultra y CosmosScope. En la tltima fase de disefio se aprendera a hacer un analisis
mas extenso para tener datos especificos del circuito, ahora como ya se ha mencionado, lo importante es
que el circuito funcione correctamente. (Synopsys, Custom WaveView™, 2014)

d. Schematic-Driven Layout. Esta fase de disefio es una fase crucial en el proceso, en esta
fase se deja de tener un esquematico que puede que sea muy comun para muchos. En esta fase de disefio se
realiza la implementacion del layout que serd el corazén del proyecto que se realiza, un buen disefio del
layout garantiza menos potencia, menos energia, tiempo de respuesta menor. En el mundo de VLSI el dise-
fio puede tener miles o hasta millones de transistores, no es nada eficiente realizar el disefio transistor por
transistor, esta opcion podria llegar a ser lo mejor en cuanto a desempefio pero llevara varios dias, meses,
afios, dependiendo del proyecto, es por eso que se usa un disefio en base a celdas, a librerias de circuitos
comunes ya realizadas que se colocan estratégicamente para lograr una mayor densidad de transistores por
unidad de area, luego de colocar las celdas se procede al que une a cada una de las celdas y a los puertos de
entrada y salida. A continuacion se muestra la celda del sumador completo que se ha estado usando como
ejemplo. Estos layout se agregan cuando se importa el archivo gds, que se explico en la instalacion de la
iPDK. (Synopsys, Custom Designer, 2014)



Figura 44: Celda estiandar de disefio
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El proceso de generar un /ayout a partir de un diagrama esquematico se denomina “Schematic-Driven
Layout” y se inicia abriendo el esquematico en el menu Tools>SDL se abre en seguida una ventana donde
se indica que se generaran dos vistas adicionales, una denominada layout y otra denominada layout.config
la primera contendra el layout y la segunda la configuracion del mismo, verificar que la libreria y la celda
de destino sean correctas y hacer click en OK. Se abre el editor de layout vacio. Centrandose en el editor de
layout se tomaran en cuenta las siguientes configuraciones o revisiones.

Cuadro 7: Configuracién de Layout Editor

Menu

Configuraciones

Tools>Constraint Manager

Se encuentran todas las restricciones que se tomaran en
cuenta al momento de hacer algin ruteo, sea automati-
co o sea manual. En otras palabras, son todas las reglas
de disefio que se deben cumplir. Las distancias o cual-
quier regla se pueden cambiar, sin embargo, esto no es
recomendable si estamos usando un iPDK ya que estan
elaborados por las empresas foundry y se debe cumplir
para una manufacturacion correcta.

Conectivity>Define Termi-
nals

Al terminar un Layout aqui deben aparecer todos los
pines/puertos que se agregaron al esquematico, asi
como la direccion del mismo y la net a la que pertene-
cen.

Options>display

Si se quiere cambiar alguna configuracion de visualiza-
cién.

Options>Design

Contiene todas las opciones que se toman en cuenta
para realizar el disefio, como angulos de pistas, nivel de
restricciones, opciones de espaciado entre las instancias
en la rejilla cuando se selecciona automaticamente el
posicionado etc.

SDL>Options

En la pestaiia pins, habilitar que se agreguen las etique-
tas de las terminales, agregarlas en la capa MxPIN drw,
donde x es la capa donde se agregaran los pines. Es
importante para la iPDK que Synopsys provee etiquetar
los pines para que el proceso de LVS sea exitoso.
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El proceso contintia con la colocacion de las instancias en el lienzo del editor de layout, esto se puede
hacer de forma automatica SDL>Generate Layout o de forma manual SDL>Pick and Place.

La forma de decidir entre qué método es mejor depende de muchos factores como las configuraciones
hechas en el programa y la complejidad del proyecto, se puede tener la mejor de las configuraciones y un
complejo proyecto que el programa tardaria demasiado en poder posicionar cada instancia sin olvidar que
luego es necesario realizar el ruteo. Lo recomendable es seguir aquel dicho que usan los programadores:
“divide y venceras” no es nada recomendable tomar un disefio de miles de miles de transistores o celdas y
esperar algiin milagro del programa diseflo. Se recomienda hacer una division en modulos del disefio y
realizar una combinacion estratégica del Generate Layout y el Pick and Place. (Synopsys, Custom
Designer, 2014)

Usando SDL>Generate Layout se abre una ventana donde se puede decidir que se posicionard y de
qué forma, en qué lugar y qué elementos simplemente se ignoran.

Figura 45: Generacion de layout

SDL Generate Layout X

Pins |

Template:lPIace Like Schematic +|
- ¥ Create Instances
[V Chain

I~ Fold

Device Class Parameter Threshold

-[v Create Pins

Top/Bottom: ||:| DIFF drw :] Wwidth:[0.044 Height:[0.044 Pitch:[0.094

Left/Right: ||:| DIFF drw j width:[0.044 Height:|0.044 pitch:[0.094

Bus Order:IDescending vl

-]~ Create Boundary

Basrs:I'-J/idth/Helght I
\*/fdth/Helght:I 1 Ut||izat|onzl70

Type: PR ¢ Snap
Help | Defaults |v| oK I Apply Cancel

Si la opcion Create instances esta seleccionada la posicion de las instancias se modificara o se agrega-
ran las que no se encuentren en el layout editor, si no estd habilitada no se modifica la posicion o la agrega-
cion de las instancias. La opcion Create Pins afiadird las terminales correspondientes al disefio, en la capa,
con las dimensiones y con el espaciado (Pitch) seleccionado. La opcion Create Boundary agrega un rectan-
gulo que envuelve a todo el die, y sobre éste se agregan las terminales en el orden y posicion especificada
en la pestaia Pins para el efecto la opcion Override Placement debe estar seleccionada (Ver la siguiente
imagen).
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Figura 46: Ubicacién de terminales

EE SDL Generate Layout X
Main  Pins |
¥ Override Placement
Name LPP Width Height [
S0 DIFF drw 0.044 0.044
Top:
Al DIFF drw 0.044 0.044
A6 DIFF drw 0.044 0.044 =l
A30 DIFF drw 0.044 0.044 -
Bottom:
S29 DIFF drw 0.044 0.044 I
VDD DIFF drw 0.044 0.044 -
A0 DIFF drw 0.044 0.044
Left:
A7 DIFF drw 0.044 0.044
S6 DIFF drw 0.044 0.044 =l
B4 DIFF drw 0.044 0.044 i]
Right: |B11 DIFF drw 0.044 0.044
B12 DIFF drw 0.044 0.044 =l
Drag and drop names to reorder or assign to a different side. Reset I

Help Defaults |v oK I Apply | Cancel |

La opcion SDL>Pick and Place es una opcion interactiva de tomar mediante un click la instancia del
editor de esquematico y posicionarla en el editor de layout.

Figura 47: Modo Pick and Place

ﬂ Pick & Place| [Single Schematic Bit v”[‘ Replace Existing 7 Instances [ Pins | L:[ﬁl ,_![_l {&3“ 4 b | @|@|v| a
= [Ahiartn avar Danal A

La barra aparece cuando se esta en el modo Pick and Place y muestra algunas opciones basicas para la
agregacion de las instancias o pines. Para configuraciones mas detalladas se usa el botén Eject de esta
barra.

En el momento en que estén todas las instancias y terminales agregadas se procede a rutear todas las
nets en Tools>Galaxy Custom Router. En el meni GCR aparecen las opciones asociadas a este proceso,
se pueden agregar Shields a alguna ruta, esto es agregar alguna ruta de VSS o VDD para evitar el crosstalk
que puede ocasionar la conmutacion de otra ruta. Para iniciar el modo de autoruteo ir a GCR>Auto Route

Figura 48: Modo Auto Route

|| Auto Route| Nets: & All ¢ Selected | ﬁ”i”ﬁl Check ” @|a3Hé]
= = = v =

Seleccionar rutas especificas o todas las rutas y hacer click en el boton Route, el proceso de auto ruteo
se iniciard y la duracion dependera de la complejidad del proyecto.
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Figura 49: Proceso de ruteo

i 29%

Al momento de terminar de rutear se tendra un layout donde inicamente faltara realizar las verificacio-
nes correspondientes en cuanto a reglas de disefio y comparacion con el esquematico para su completa
finalizacion. Esto se hara en la siguiente fase de disefio.

e. DRCy LVS. En esta fase de disefio se realiza la verificacion de las reglas de disefio (De-
sign Rules Checking) y la verificacion fisica del disefio (Layout Vs. Schematic). Esta fase es crucial para
lograr un disefio que pueda ser fabricado, es necesario cumplir con las reglas de disefio para que la empresa
de manufactura pueda implementar lo requerido y es necesario que el esquematico, que ya se sabe que
funciona correctamente por la fase de simulacion y analisis, sea idéntico a lo implementado en el layout.
Ambos procesos son bastante sencillos pero en ocasiones podra requerir de mucha paciencia para solucio-
nar cualquier violacion encontrada. (Synopsys, IC Validator, 2014)

Para el proceso DRC vaya al menu Verification>DRC>Setup and Run en el siguiente cuadro se ex-
plican las configuraciones y los aspectos que se deben tomar en cuenta.

Cuadro 8: Configuracién de DRC

Seccién | Explicacion
Pestaila Main
Run Dir. Un directorio donde se guardaran todos los resultados,
logs y archivos necesarios para el proceso DRC.
Format. Galaxy custom Layout trabaja con el formato OpenAc-

cess, normalmente se elige éste, pero no debiera haber
ningun inconveniente en realizar el proceso con forma-

to Stream.

Library, Cell y View Verificar que la libreria, la celda y la vista sean las
correctas para ejecutar el proceso.

Tool La herramienta que se usara para realizar el proceso,

actualmente se usa con frecuencia IC Validator pero
existen otras herramientas como Hercules.

Runset Es el archivo que contiene las reglas de disefio y como
estas se manejan, normalmente cuando se configura un
iPDK las rutas a estos archivos se agregan por defecto.
Si existiera algun problema con la agregacion, el archi-
Vo se ubica en:
/usr/synopsys/iPDK/SAED32 28 iPDK//ic
v/drc/saed32nm 1p9m drc rules.rs

Que puede variar segun el directorio donde se hayan
instalado los archivos de las librerias agregadas.
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Continuacion de Cuadro 8.

View Output Al finalizar el proceso se abre una ventana donde
se muestran los logs del proceso y errores encontrados.
Pestaiia Custom Option

Es el archivo de la tecnologia que se usa, en €l se espe-
cifican aspectos importantes sobre las distintas capas
Layer Map de metal. Se ubica en:
/usr/synopsys/iPDK/SAED32 28 iPDK//te
chfiles/saed32nm 1p9m gdsout.map

Cuando la configuracién se ha terminado se procede a dar click en OK. El proceso comenzard y luego
mediante una ventana de la aplicacion que llevo a cabo el proceso (IC Validator, Hercules) se notificara las
violaciones encontradas. (Synopsys, IC Validator, 2014)

Figura 50: Verificaciones DRC

VUE: RHEL64 Release J-2014.06.5P1.14024 2014/07/17
ile View Tools (Classification Windows Help

-
E

4 9 K@ h Q r(i rd f Check Highlight ~ Marker Highlight

Execution | LoadResults | Run Summary = DRC Emrors

Layout Cells |sortby  4|@ Violations Highlight All Violations | Sortby 4 |@
Full_Adder_32bits/Full_Adder_32bit/layout]| 28 M1.S.8 Minimum spacing to neighboring VIA1 must be 0.08
o

Violation Detail
M1.S.8 Minimum spacing to neighboring VIA1 must be 0.08

Error List: external2 Highlight All Errors
Status # ~ (lowerleftx,y) (upperright x,y)  Distance User Comment B
Error 1 (5.6640, -15.4650) (5.7120, -15.4010) 0.0640 ‘
® Error 2 (5.7620, -15.4650) (5.8100, -15.4010) 0.0640
® Error 3 (5.7120, -15.4650) (5.7620, -15.4010) 0.0640
® Error 4 (2.0480, -10.8470) (2.1060, -10.7920) 0.0550
® Error 5 (2.1560, -10.8470) (2.2140, -10.7920) 0.0550
@® Error 6 (2.1060, -10.8470) (2.1560, -10.7920) 0.0550
74

® Error (5.6540, -10.8470) (5.7120, -10.7920) 0.0550

Show Error Details |Zoom # |[0.80 7] Go To: 1 $8

Classify Errors

[ v|[ watch | ignore | waive | Fixed | Error

[C|EETEERT| [s|No cONNECTION

Las violaciones encontradas son faciles de ubicar y reparar manualmente debido a la interaccidén que se
tiene mediante el sistema operativo, IC Validator o Hercules y Custom Designer. Cada vez que se resalta
un error el editor de layout se magnifica en las coordenadas donde se encontr6 la violacion. Por ejemplo la
siguiente violacion encontrada, mostrada en la siguiente figura, muestra una violacién en cuanto a la dis-
tancia que debe haber en una VIA de capa 1 a capa 2 de metal hacia una pista de metal capa 1.
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Figura 51: Error identificado en proceso DRC

La marca amarilla muestra el lugar exacto de la violacién, en este caso una violaciéon de distancias co-
mo ya se ha explicado. El nimero de tipos de errores que puede ocurrir es muy extenso, sin embargo, por la
interactividad de las aplicaciones sera facil ubicarlos y corregirlos. El resultado satisfactorio debe lucir algo
como:

Figura 52: DRC exitoso

B 45 /home/Electronica/Desktop/Folder_de_Trabajo/pvjob_Full_Adder_32bits.Full_Adder_32bit.it - o x
File Edit View Window Help

-ull_Adder_32bit.drc.cdesigner.rc | Full_Adder_32bit.RESULTS  Full_Adder_32bit.LAYOUT_ERRORS I stdout.drc.log |4 )

LAYOUT ERRORS RESULTS: CLEAN

#3238 2 L2221 ## # #
# # # % 8% 3
# # BREF RRREER B % %
# # # # # 8 8%

FREE BRRRE BERRR 3 LI T

Library name: Full_Adder_32bits
Structure name: Full_Adder_32bit
Generated by: IC Validator RHEL64 Release J-2014.06.5P1.14030 2014/07/14

Para la ejecucion de LVS vaya a Verification>LVS>Run and Setup, el proceso de configuracion es
muy similar al de DRC. En el siguiente cuadro se especifican algunos detalles.



Cuadro 9: Configuracién de LVS

Seccion | Explicacion
Pestafia Main

Run dir El directorio donde se ejecutara el proceso y se guarda-

ran todos los resultados y logs del mismo.
Layout y Schematic Especificar las librerias, las celdas y las vistas tanto del

layout y del esquematico que se van a comparar.
Tool La aplicacion que se usard para ejecutar LVS.
View Output Para ver los logs y demas resultados al terminar el

proceso.

Netlisting Option

Schematic Netlist Direccion del deck que se extraera del esquematico,

normalmente es una ubicacion dentro del Run dir.
Netlister Formato de salida del deck.
View Search List y View | Configuracion de la busqueda jerarquica en las vistas

Stop List. para la generacion del deck.

Pestaiia Custom Option

Al igual que el DRC, especifica la ubicacion del archi-

vo de tecnologia de las diferentes capas de metal. Ubi-
Layer Map: cado en:

/usr/synopsys/iPDK/SAED32 28 iPDK//te

chfiles/saed32nm 1p9m gdsout.map
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El sistema interactivo también hara facil el poder ubicar un error y corregirlo, de la misma forma que
con el DRC. Un proceso exitoso si errores se mostrara con el siguiente resultado.

Figura 53: LVS Exitoso

VUE: RHEL64 Release J-2014.06.5P1.14024 2014/07/17 = g%

File View Tools Classification Windows Help

D |

Execution | Load Results = Run Summary | LVS Ermors

TOP BLOCK COMPARE RESULTS

PASS
[Full_Adder_32bit, Full_Adder_32bit]

IC Validator (R) Hierarchical Design Verification, RHEL64 Release J-2014.06.5P1.14030 2014/07/14
IC Validator Run: Time=0:00:09

Netlist Extraction Statistics

Library name: Full Adder 32bits
Structure name: Full Adder 32bit
Generated by: IC Validator RHEL64 Release J-2014.06.SP1.14030 2014/07/14

Layout vs. Schematic Statistics

Schematic: /home/Electronica/Desktop/Folder_de_Trabajo/pvjob_Full Adder_32bits.Full_Adder_ 32bit.icv.lvs/Full_Adder_ 32bit.sck

LVS Errors:

1 successful equivalencies
0 failed equivalencies

Cuando se logren ambas verificaciones exitosas se tendra un layout que puede ser fabricado por el

foundry que provey6 el iPDK que se uso para el disefio. Las siguientes fases mostraran resultados basica-
mente de como se comportara nuestro circuito en vida real, tomando en cuenta las capacitancias parasitas a
lo largo de cada net, si los resultados en las siguientes fases no son los deseados, se debe hacer modifica-
ciones de optimizacion del disefio (puede requerir el uso de aplicaciones avanzadas) y volver a ejecutar

todas las fases de disefio. (Synopsys, IC Validator, 2014)
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f- Extraccion. Esta seccidon corresponde a la obtencion de un deck que se asemeje mas a la
realidad en cuanto a simulacion, esto es debido a que se ejecuta un proceso donde se calculan de manera
muy acertada todas las capacitancias, inductancias y resistencias parasitas que se generan con el disefio de
layout que hasta este paso ya se tiene. El proceso es sencillo y de alta utilidad, la aplicacion que se integra
al entorno de Galaxy Custom Designer es StarRC y como requisito ya se debid haber realizado el LVS ya
que se necesitan algunos archivos generados en este proceso. (Synopsys, Extraction & Layout Analysis,
2014). Para poner en marcha el proceso dirijase a Verification>LPE>Setup and Run, se especifican las
configuraciones bésicas en el siguiente cuadro.

Cuadro 10: Configuracién de LPE

Seccion | Explicaciéon
Pestaiia Main

Run Dir Al igual que en los casos anteriores, el directorio donde
se guardan los archivos generados en el proceso.

Library, Cell y View Verificar que la libreria, la celda y la vista sean las co-
rrectas.

Tool Elegir StarRC, a menos que se prefiera alguna otra dis-
ponible.

Runset Especifica la ubicacion del archivo que rige como se

hara la extraccion de parasitos, normalmente se agrega
por defecto y se ubica en:
/usr/synopsys/iPDK/SAED32 28 iPDK//st
arrc/icv_cmd/saed32nm 1p9m star nomin

al.cmd
Pestaiia Extraction Options
LVS Tool Es la aplicacion que se usé para el proceso LVS.
Runset report File La ubicacion del archivo pex runset report este

se encuentra en el Run Dir del proceso LVS.
Archivo de tecnologia que se usa para la extraccion de

parasitos.

TCAD GRD File /usr/synopsys/iPDK/SAED32 28 iPDK//st
arrc/nominal/saed32nm 1p9m nominal.nx
tgrd

Es el tipo de extraccion que se realizara: R, C, RC,
RKC. Esto se refiere a si se tomardn en cuenta so6lo las
Extraction Type resistencias parasitas, las capacitancias, capacitancias y
resistencias o capacitancias, resistencias e inductancias
respectivamente.
Pestaiia Qutput Options

El formato del archivo de salida, es el formato del deck
Format final con parasitos. Se recomienda usar el formato SPF
que es en texto plano para poder usarlo en otras aplica-
ciones mas facilmente.

Netlist File Direccién del deck final.
Si se desea usar el mismo orden de las terminales del
Netlist Port Order File LVS, se debe especificar el netlist generado en el proce-

so LVS normalmente con terminacion de nombre
*.cdesgner.sp.

Cuando la configuracion ya esté realizada dar click en OK y el proceso iniciara.
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Figura 54: Extraccion de parasitos

8 /home/Electronica/Desktop/Folder_de_Trabajo/pvjob_Full_Adder_32bits.Full_Adder_32bit.sti - o0 x

File Edit View Window Help

saed32nm_1p9m_star_nominal.cdesigner.cmd | Full_Adder_32bit.star_sum  stdout.lpe.log

™ &4
Completed 70% Time=00:00:00 RemainingTime=00:00:00 Mem=117.488 |
Completed 80% Time=00:00:00 RemainingTime=00:00:00 Mem=117.863
Completed 90% Time=00:00:00 RemainingTime=00:00:00 Mem=118.113
Completed 100% Time=00:00:00 RemainingTime=00:00:00 Mem=120.02
WARNING: found open net(s) in the design. please check opens.sum file. (Ex-414)
WARNING: found open net(s) in the design. please check opens.sum file. (Ex-414)
Warnings: 2 Errors: 0 (See file summary/netlist.sum)
Netlist Elp=00:00:01 Cpu=00:00:00 Usr=0.9 Sys=0.0 Mem=120.0

Done

Layers Elp=00:00:00 Cpu=00:00:00 Usr=0.6 Sys=0.0 Mem=200.3
Models Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=84.4
HN Elp=00:00:01 Cpu=00:00:00 Usr=0.3 Sys=0.0 Mem=216.9
XrefHN Elp=00:00:00 Cpu=00:00:00 Usr=0.1 Sys=0.0 Mem=105.3
cells Elp=00:00:00 Cpu=00:00:00 Usr=0.2 Sys=0.0 Mem=200.3

Translate Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=101.5
XinMerge Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=108.0
NetlistSetup  Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=100.6
Partition_partl Elp=00:00:01 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=106.1
PartitionPP Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=85.6
xTract_partl  Elp=00:00:07 Cpu=00:00:06 Usr=6.6 Sys=0.1 Mem=165.4
xTractPP Elp=00:00:00 Cpu=00:00:00 Usr=0.1 Sys=0.0 Mem=65.3
ReportViolations Elp=00:00:00 Cpu=00:00:00 Usr=0.0 Sys=0.0 Mem=0.0
Netlist Elp=00:00:01 Cpu=00:00:00 Usr=0.9 Sys=0.0 Mem=120.0

Done Elp=00:00:10 Cpu=00:00:08 Usr=8.8 Sys=0.1 Mem=216.9

v

® Find: | 7 Next A Previousl I~ Match Case [~ Regexp
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Al finalizar el proceso se presentara una ventana similar a la anterior, el deck final esta ahora en la di-
reccion que se eligio en el proceso de configuracion. (Synopsys, Extraction & Layout Analysis, 2014)

g. Verificacién Post-Layout. Esta fase de disefio es una fase extremadamente importante ya
que consiste en poder caracterizar nuestro circuito. Caracterizar se refiere a conocer aspectos del circuito
que son cruciales en su funcionamiento, como la potencia disipada, la energia necesaria, y el tiempo maxi-
mo que se tarda para realizar una operacion. Esta ultima caracteristica resulta un poco dificil de encontrar,
ya que es necesario analizar cada una de las rutas que se usan para lograr un resultado, con todas las posi-
bles combinaciones en los vectores de entrada. En ocasiones la ruta mas larga puede ser obvia, o si no lo es
puede ser facil realizar iteraciones con las combinaciones en los vectores de entrada que produzcan un
cambio en la salida, pero en proyectos muy complicados no es ni obvio ni de facil iteracion. Para esto se
usan aplicaciones especificas como PrimeTime y NanoTime, la primera de ellas a nivel de compuertas,
cuando se tenga el circuito descrito con un archivo HDL de Verilog y la segunda es a nivel de transistores.

Cuando la ruta mas larga sea una combinacion de vectores de entrada obvia, el analisis se puede reali-
zar usando Hspice, la herramienta por excelencia de simulacion de circuitos que es el motor del SAE que se
usé con anterioridad. Los manuales de usuario de Hspice (Synopsys, HSPICE, 2014) como tal son dema-
siado extensos, podria tomar varios afios en poner en practica todo lo que se puede hacer con esta aplica-
cion. Un comando muy usado para obtener las caracteristicas del circuito es el .measure que puede ser
usado de muchas formas.

A continuacion se muestran algunas lineas con las que se puede obtener el retraso de propagacion de
una ruta critica simple, la medicion de potencia promedio, potencia maxima y operaciones matematicas
con resultados de estas mediciones.

.measure tran tpdr trig V(cin) wval='0.5*1.05"' rise=1
+ targ=V(cout) wval='0.5*1.05"' rise=1
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Esto se puede leer como: medir el tiempo desde que el primer flanco de subida en el nodo cin tenga el
valor de 0.5%1.05 V hasta el primer flanco de subida en el nodo cout cuando tenga 0.5%1.05 V.
(Synopsys, HSPICE, 2014)

.measure tran POTavg AVG P (V1) from=20n to=22.3n

La potencia promedio del elemento V1 en el intervalo de tiempo 20 ns a 22.3 ns.

.measure tran POTmax MAX P (V1) from=20n to=22.3n
La potencia maxima del elemento V1 en el intervalo de tiempo 20 ns a 22.3 ns.
.measure energy param='POTavg* (22.3n-20n)"'

Calculo de la energia mediante la potencia media calculada.

Hspice es una herramienta magnificamente poderosa y de extrema confiabilidad, todo su potencial
puede aprovecharse para obtener datos del circuito que pueden ayudar al disefiador a mejorar su producto

final. Ya se ha mencionado que toda la teoria sobre el uso de Hspice es muy extensa, sin embargo, con el

SAE, que ya se ha configurado y utilizado se puede aprovechar de una manera facil una mayor parte de
Hspice.
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Figura 56: Layout de primera versién de sumador de 32 bits

Un resumen de los resultados obtenidos en el disefio de esta primera version se muestra en el siguiente
cuadro.

Cuadro 11: Resultados obtenidos en primera version de sumador de 32 bits

Tecnologia CMOS de 130 nm
Area de silicio 94 x 80 (um)?
Retraso de propagacion (sin ex- 1.5 ns

traccion de parasitos)
Frecuencia maxima de operacion 667 MHz
Potencia promedio 9 uWw
Densidad 15 MT/em?

Es importante mencionar que esta primera version carece de una verificacion de reglas de disefio y de
una extraccion de parasitos lo cual puede afectar drasticamente los resultados que se presentan en el cuadro
anterior. Sin embargo, se aprovecharan estos datos para discutir los resultados obtenidos en el disefio reali-
zado en este trabajo en las secciones posteriores. (Universidad del Valle de Guatemala, 2013)



V. METODOLOGIA
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e Descarga de archivos

e Instalacién de CentOS

e Instalacién de SCL

e Implementacién de SCL

e [nstalacién de
librerias

e Elaboracion de guias
de uso

e Investigacion sobre
librerias de pads

* Implementacion de
pad-ring

® Pruebas y andlisis
usando pads



52



VI. RESULTADOS

El circuito que se implementd consiste en un Ripple Carry Adder, este circuito consta de sumadores
completos de 1 bits realizando un conexién en cascada. Debido a que no s6lo se necesitaba un sumador
sino que también, de alguna forma se queria restar lasr entradas se agregé compuertas XOR a la entrada de
uno de los digitos a operar, esto para que con una sefal de control pueda invertirse y sumarsele 1 mediante
el Carry In para que se convierta la entrada a complemento a 2. La siguiente figura muestra el circuito im-
plementado. (Kem, 2014)

Figura 57: Diagrama esquematico de un sumador/restador

A7 B7 A6 B6 A5 B5 A4 B4 A3 B3 A2 B2 A1 B1 A0 BO 0

ISR N O O O
T 1To T4 T80 178 T8 178 88

v IV IV IV Y VY Y Y

FA |« FA |« FA |« FA |« FA |« FA |« FA [« FA

' v v ' v v v v

S7 S6 S5 S4 S3 S2 S1 S0

SUB

El disefio final obtenido entonces muestra la siguiente tabla de verdad, con la que se puede resumir su
funcionamiento.

Cuadro 12: Tabla de verdad del diseio final

S C S[ 1
UB IN
0 0 A[]+B[]
0 1 A[]+B[]+1
1 0 A[]-B[]
1 1 Estado no permiti-
do

Luego de pasar por las diferentes fases de disefio se obtuvieron resultados satisfactorios en cuanto a los
procesos de verificacion DRC y LVS como en los diferentes anélisis de simulaciéon. A continuacion se
presentan los resultados de forma ordenada respecto al proceso de disefo.
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Figura 58: Diagrama esquematico final
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Figura 59: Esquematico para testbench
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Figura 62: Transicién L-H de todas las sefiales en ruta critica
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Figura 64: Ruta critica CIN (falling) At =832 ps
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Figura 65: Ruta critica B0 (rising) At =1.05 ns
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Figura 66: Ruta critica B0 (falling) At =838 ps
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Figura 67: Ruta critica A0 (rising) At=1.03 ns
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Figura 68: Ruta critica A0 (falling) At =805 ps
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Figura 69: Layout final (die)
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Figura 70: Verificacién de reglas de disefio exitosa

¥ 45 /home/Electronica/Desktop/Folder_de_Trabajo/pvjob_Full Adder_32bits.Full_Adder_32bit.ii - 0 x
File Edit View Window Help

-ull_Adder_32bit.drc.cdesigner.rc | Full Adder_32bit RESULTS  Full_Adder_32bit.LAYOUT_ERRORS | stdout.drc.log |4

LAYOUT ERRORS RESULTS: CLEAN
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wRAT HARRSR wERAAE # i 4

Library name: Full_Adder_32bits
Structure name: Full_Adder_32bit
Generated by: IC Validator RHEL64 Release J-2014.06.5P1.14030 2014/07/14

Figura 71: Comparacion de esquematico contra layout exitosa

| VUE: RHEL64 Release J-2014.06.5P1.14024 2014/07/17 I X
File View Tools Classification Windows Help

0 R Qg 6

Execution | Load Results | RunSummary | LVS Ermors

TOP BLOCK COMPARE RESULTS

PASS
[Full_Adder_32bit, Full_Adder_32bit]

IC Validator (R) Hierarchical Design Verification, RHEL64 Release J-2014.06.5P1.14030 2014/07/14
IC Validator Run: Time=0:00:09

Netlist Extraction Statistics

Library name: Full_Adder 32bits
Structure name: Full Adder_ 32bit
Generated by: IC Validator RHEL64 Release J-2014.06.SP1.14030 2014/07/14

Layout vs. Schematic Statistics

Schematic: /home/Electronica/Deskt op/Folder_de_Traba jo/ ‘pvjob_Full Adder 32bits.Full Adder 32bit.icv.1l vs/Full_Adder_32bit.sck

LVS Errors:

1 successful equivalencies
0 failed equivalencies



71784 XMXI132|MMN6 XI132|MMN6:
as=0.02754p 1=0.03u m=1
71785 XMXI132|MMN7 XI132|MMNT:
as=0.04284p 1=0.03u m=1
71786 XMXI132|MMP1 XI132|MMP1:
as=0.03672p 1=0.03u m=1
71787 XMXI132|MMP2 XI132|MMP2:
as=0.03366p 1=0.03u m=1
71788 XMXI132|MMP3 XI132|MMP3:
as=0.03366p 1=0.03u m=1
71789 XMXI132|MMP4 XI132|MMP4:
ad=0.03366p as=0.03366p
71790 XMXI132|MMPS XI132|MMPS:
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Figura 72: Deck con parasitos (muestra)

DRN XI132|MMN6:GATE VSS
nf=1 nrd=0.377778 nrs=0.
DRN XI132|MMN7:GATE VSS
nf=1 nrd=0.242857 nrs=0.
DRN XI132|MMP1:GATE VDD
nf=1 nrd=0.283333 nrs=0.
DRN XI132|MMP2:GATE VDD
nf=1 nrd=0.309091 nrs=0.
DRN XI132|MMP3:GATE VDD
nf=1 nrd=0.309091 nrs=0.

VSS nl05 SCA=72.6261 SCB=0.0449695 SCC=0.00974379 ad=0.02754p
377778 pd=0.744u ps=0.744u w=0.27u
VSS nl05 SCA=95.3561 SCB=0.0439188 SCC=0.0101565 ad=0.04284p
242857 pd=1.044u ps=1.044u w=0.42u
VDD pl05 SCA=59.1158 SCB=0.0550513 SCC=0.00733071 ad=0.03672p
283333 pd=0.924u ps=0.924u w=0.36u
VDD pl05 SCA=60.2967 SCB=0.0623035 SCC=0.00738467 ad=0.03366p
309091 pd=0.864u ps=0.864u w=0.33u
VDD pl05 SCA=56.237 SCB=0.0550496 SCC=0.00691423 ad=0.03366p
309091 pd=0.864u ps=0.864u w=0.33u

DRN XI132|MMP4:GATE XI132|MMP4:SRC VDD pl05 SCA=55.2788 SCB=0.0530149 SCC=0.00686298
1=0.03u m=1 nf=1 nrd=0.309091 nrs=0.309091 pd=0.864u ps=0.864u w=0.33u

DRN XI132|MMP5:GATE VDD

VDD pl05 SCA=77.9536 SCB=0.0763946 SCC=0.01096 ad=0.0408p as=0.0408p

1=0.03u m=1 nf=1 nrd=0.255 nrs=0.255 pd=1.004u ps=1.004u w=0.4u

71791 XMXI132|MMP6 XI132|MMP6:DRN XI132|MMP6:GATE XI132|MMP6:SRC VDD pl05 SCA=62.5933 SCB=0.0623076 SCC=0.00771724
ad=0.0408p as=0.0408p 1=0.03u m=1 nf=1 nrd=0.255 nrs=0.255 pd=1.004u ps=1.004u w=0.4u

71792 XMXI132|MMP7 XI132|MMP7:DRN XI132|MMP7:GATE VDD VDD pl05 SCA=115.307 SCB=0.0754836 SCC=0.0136763 ad=0.0765p as=0.0765p
1=0.03u m=1 nf=1 nrd=0.136 nrs=0.136 pd=1.704u ps=1.704u w=0.75u

En las siguientes imagenes se muestran los analisis realizados tomando en cuenta la extraccion de para-
sitos de resistencias y capacitancias.

Figura 73: Ruta

critica CIN (rising) At =2.11 ns
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Figura 74: Ruta critica CIN (falling) At =1.7 ns
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Figura 75: Ruta critica B0 (rising) At=2.12 ns
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Figura 76: Ruta critica B0 (falling) At=1.71 ns
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Figura 78: Ruta critica A0 (falling) At =1.64 ns
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Figura 79: Transicién H-L de las sefiales en ruta critica
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Figura 80: Transicion L-H de las sefiales en ruta critica
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Cuadro 13: Resumen de resultados obtenidos

Tecnologia CMOS de 28 nm
Area de silicio (die) 30 x 30 (um)?
Retraso de propagacion 2.12 ns.
Frecuencia maxima de operacion 471.7 MHz
Potencia promedio -112.7054 pW
Energia -238.0362 f]
Numero de transistores 1372

Densidad 152.4 MT/(cm)?

Las graficas que muestran a continuacioén presentan los resultados obtenidos agregando al die el pad
ring.



Figura 81: Diseiio final
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Figura 82: Ruta critica con pad's B0 (rising) At = 4.56 ns
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Figura 83: Ruta critica con pad's B0 (falling) At = 4.54 ns
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VII. ANALISIS DE RESULTADOS

El capitulo anterior muestra un proceso de disefio con resultados satisfactorios, estos resultados fueron
obtenidos después de muchas pruebas y correcciones tanto en la plataforma de trabajo como en el disefio en
si. Los problemas en la plataforma de trabajo resultaron de una instalacion correcta pero de una configura-
cion en el sistema operativo CentOS incompleta. Por ejemplo, cuando se necesitaba realizar el proceso de
extraccion de parasitos no se podia comunicar el Galaxy Custom Designer con StarRC, el log de la ejecu-
cion mostraba un error que indicaba que uno de los archivos necesarios faltaba, este problema similar a
muchos otros ocurridos con las demas aplicaciones surgia debido a la falta de alguna variable de entorno o
la que existia apuntaba a un directorio incorrecto. Las variables de entorno son de vital importancia para
que las aplicaciones se puedan comunicar entre si y también con el sistema operativo en general. Desde un
principio se sabia que se iban a tener problemas de este tipo por la experiencia que se tiene en el uso de
diversas distribuciones de Linux; aunque los manuales de instalacion se siguieron al pie de la letra algunos
de ellos no especificaban el nombre de la variable de entorno o la direccion que se sugeria era incorrecta,
quiza por cambios en las nuevas versiones. Como primera aplicacion desarrollada en este ambiente de
trabajo se pretendia superar todos estos problemas con las aplicaciones, dejar todas las configuraciones en
un estado Optimo para permitir que en el futuro se dedique inicamente al disefio sin tener problemas con el
entorno de trabajo. Un archivo de vital importancia es $SHOME/ .bashrc este archivo es de personaliza-
cion del usuario hacia el sistema operativo, en el entorno Linux se puede usar para diversas cosas, en este
trabajo se ha usado para especificar las variables de entorno necesarias para el correcto funcionamiento de
las aplicaciones de disefio. El Cuadro 4 muestra una referencia de como este archivo deberia editarse para
obtener los resultados deseados, también es importante notar que no es posible especificar las variables de
entorno para todas las aplicaciones que Synopsys provee por lo que es recomendable, al instalar una aplica-
cion leer el manual de instalacion, especificamente la seccion de configuracion con el entorno. Las aplica-
ciones quedaron apropiadamente instaladas dando al laboratorio de electronica de la Universidad del Valle
de Guatemala la suite de herramientas profesionales para disefio de circuitos a muy gran escala. El tnico
inconveniente que se tuvo con los objetivos planteados es el de la implementacion del método de logical
effort ya que no se pudo llevar a cabo por la utilizacion de celdas estandares de disefio. Para poder aplicar
logical effort es necesario hacer el diseflo transistor por transistor debido a que los transistores de las dife-
rentes rutas tienen diferentes tamafos, este tipo de diseflo queda entonces fuera del alcance de este docu-
mento.

Synopsys recomienda el disefio en 7 fases que tienen un orden légico y hacen muy eficiente la obten-
cion de un resultado final. A continuacion se irdn detallando cada una de las fases haciendo referencia a los
resultados obtenidos y mencionando los hallazgos encontrados. La primera fase es la realizacion del dia-
grama esquematico, la Figura 58 muestra el disefio esquematico final como primera fase de disefio. El cir-
cuito consta de varios sumadores completos de 1 bit colocados en cascada como lo muestra la figura 57 y
compuertas XOR que con la adicion de la entrada CIN convierten uno de los vectores de entrada en com-
plemento a 2. Es importante mencionar que cada una de estas pequefias cajas negras esta construida a nivel
transistor en su interior.

Siguiendo el proceso de disefio se observa en la Figura 59 que se cred una caja negra, que es el suma-
dor/restador completo con todos los pines de entrada y salida que tendria ya implementado fuera del empa-
quetado final, este esquematico para pruebas (festbench) se realizd con dos objetivos, el primero fue para
verificar el correcto funcionamiento del disefio, que es la segunda fase de disefio, y el segundo dejar una
instancia que pueda ser usada en otros disefios que requieran de un sumador/restador de 32 bits, esta es una
buena practica para hacer mas simples los procesos de disefio e implementacion. Al circuito de la Figura 59
se le inyectaron sefiales para poder proceder con las simulaciones respectivas y analizar el resultado de las
mismas. La versatilidad del graficador que ofrece la aplicacion Custom Explorer y la integracion con Cus-
tom Designer hizo verdaderamente simple esta labor. La Figura 60 muestra el resultado de las simulaciones
graficando cada sefal de salida con respecto al tiempo. Las sefiales cambian debido al cambio que se hizo
intencionalmente en las entradas CIN y SUB para analizar tanto la suma de los nimeros binarios como la
resta de los mismos. El analisis de los resultados de la simulacién es la 3ra etapa de diseflo, note que en esta
fase debemos obtener los resultados que deseamos, no tanto en aspectos como potencia o tiempos de opera-
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cion pero si en los niveles de voltaje que se esperan en la salida. Por ejemplo, en el caso de este proyecto,
en esta fase ya debe ser posible realizar sumas y restas, las pruebas se realizaron a una frecuencia adecuada
para saber que el circuito si funciona. Varias veces fueron las que no se obtuvieron resultados satisfacto-
rios, al principio de creyo que era por la velocidad en la que se realizaban las transiciones de los estados por
lo que se disminuy6 la frecuencia de operacion, y seguia sin funcionar. Todo indicaba que era una mala
conexion en la circuiteria que conforma el esquematico y asi fue. Puede ser una tarea realmente dificil
encontrar este tipo de errores, como el lector seguramente sabe por simulaciones realizadas en otros entor-
nos, por lo que se recomienda tener mucho cuidado en la primera fase de disefio. Como es 16gico, sin tener
los resultados que se esperan no se puede pasar a las siguientes etapas de disefo.

La cuarta etapa de disefio es la generacion del layout, una fase que probablemente todos los interesados
en la nanoelectronica estan ansiosos en llegar. La maravilla que ahora son las aplicaciones de disefio como
las que Synopsys provee hacen de esta tarea, una labor relativamente simple. El proceso se denomina
Schematic Driven Layout (SDL) como ya se ha explicado en las guias rapidas de uso de las aplicaciones
que conforman el marco teodrico de este documento. En esta fase se usd6 una combinacion estratégica de
posicionamiento de las instancias en el editor de layout del generador automatico y del pick and place esto
para tener un disefio mas ordenado y probablemente mas eficiente en cuanto a area. Luego de tener las
instancias debidamente alineadas y debidamente ubicadas se procede a realizar el proceso de auto ruteo,
esta funcion normalmente la logra hacer en su totalidad Galaxy Custom Designer pero suele fallar cuando
se le indica que rutee todas las pistas de golpe. Lo que se hizo fue rutear todas las rutas y al terminar el
proceso en la Custom Designer Console se imprime un sumario de cudles rutas fueron completadas y cua-
les no, de las que no fueron ruteadas se repite el proceso indicando que rutee solo éstas faltantes y asi hasta
completar el 100% del ruteo. Si en algun caso no fuera posible por parte del programa hacer el ruteo puede
rutearse a mano, estos errores se encontraran en las siguientes fases de disefio. La Figura 69 muestra el die
final obtenido.

La quita etapa es la de la verificacion fisica del disefio, los errores obtenidos en el proceso de disefio
fueron detecciones de violaciones en las reglas de disefio y errores en la comparacion del esquematico con
el layout generado. Los problemas de DRC aunque en general fue un nimero grande de violaciones encon-
tradas fueron faciles de solucionar debido a que el programa IC Validator como ya se ha mencionado se
comunica con el Layout Editor de Custom designer y ubica el error marcandolo con una malla amarilla
(que puede ser modificada desde IC Validator) como lo muestra la Figura 51. En el proceso LVS también
se encontraron algunas desigualdades, LVS por ser un proceso de IC Validator también se comunica con
Custom Designer e identifica y ubica el error de la misma forma que DRC. Los problemas que se encuen-
tren durante la ejecucion de LVS son producto de un mal ruteo en las distintas capas de metal, y un mal
ruteo puede originarse por alguna deficiencia en la configuracion del Auto Route o porque simplemente el
software no fue capaz de hacer la conexion con las restricciones impuestas. Normalmente el Auto Route
realiza la mayoria de conexiones sin ningln problema, en el proceso del disefio del sumador/restador fue-
ron 2 conexiones las que no se conectaron automaticamente las cuales fueron detectadas facilmente con los
resultados del LVS y fueron realizadas las conexiones manualmente que también se ofrece una forma muy
intuitiva de realizarlo. Se puede ver en las figuras 70 y 71 el resultado satisfactorio de las verificaciones
DRC y LVS respectivamente.

Hasta este punto ya se tiene un layout completamente terminado, pero es necesario analizar como se
comportara el circuito con este disefio de layout, las simulaciones realizadas con anterioridad muestran el
correcto funcionamiento a nivel esquematico, pero no se toman en cuenta los efectos que el layout agrega
al circuito. Para poder analizar estos efectos es necesario ejecutar un proceso llamado LPE (Layout Parasi-
tic Extaction), que realiza una extraccion de capacitancias, inductancias y resistencias parasitas y las inter-
conecta en un deck con el resto del circuito a nivel de transistores, esta es la sexta etapa de disefio. Este
analisis es crucial para la verificacion de potencia disipada y tiempo de retraso de propagacion y aspectos
mucho mas especificos que no se cubren en este documento, recordemos que este es un campo de investi-
gacién muy amplio. La figura 72 muestra una parte del deck generado por este proceso, este deck se agrega
como una vista Hspice a la celda del proyecto y se procede a verificar con el mismo testbench realizado con
anterioridad, especificando en la jerarquia que se use el Hspice en lugar del Schematic.
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Con el deck obtenido se hicieron varias simulaciones, este analisis es la séptima y ultima etapa de dise-
flo, para la verificacion de que el sistema seguia funcionando de forma correcta, el “cableado” que se hace
en el layout puede ser tan impactante que la aplicacion deje de funcionar. Las simulaciones fueron exitosas,
sin embargo, se ve la clara presencia de capacitores interconectados en el circuito ya que las salidas presen-
tan la forma de carga y descarga de un capacitor mucho mas definida, es decir, una carga o descarga que
requiere mas tiempo. En la seccion de resultados varias son las figuras que muestran el retraso de propaga-
cion medido en el circuito, en este caso la ruta critica es obvia y se obtiene cuando los valores de un vector
de entradas son todos 1, y las del otro son todas 0 y el CIN cambia de 0 a 1, o bien el CIN permanece en 0 y
el bit menos significativo de un vector, cambia de 0 a 1 mientras que el bit 0 del otro vector esta en 1. En
cualquiera los dos casos el acarreo de salida de cada sumador completo de 1 bit conmuta de 0 a 1, haciendo
que en el siguiente sumador se realice la misma conmutacion y asi hasta que COUT realiza un flanco de
subida, esta es la ruta critica y el tiempo para realizar esa operacion sera el tiempo maximo de operacion y
la potencia disipada por la fuente al realizar esa operacion sera la potencia promedio maxima por operacion
y por lo tanto la energia maxima que se requiere para hacer una operacion. En el Cuadro 13 se muestran los
resultados obtenidos de estas mediciones. Se observa que el retraso de propagacion es de 2.12 ns, es un
numero de vital importancia ya que marcara la frecuencia a la que puede operar el dispositivo que es de
471.7 MHz. Si se compara con los resultados obtenidos en la primera version del circuito presentada en el
capitulo 5 vemos que los resultados de esta version pueden ser peores, sin embargo esto no es asi ya que en
la primera version no se realizo una extraccion de parasitos. Para poder comparar de mejor forma las mejo-
ras se hizo el analisis del retraso de propagacion sin tomar en cuenta las capacitancias parasitas, esto se
muestra en las figuras 63 a 68, se nota un retraso de propagacion de 1.05 ns, que produce una frecuencia de
operacion de 952.38 MHz demostrando asi la mejora en el proceso.

Otro aspecto a discutir es la energia usada para realizar la operacion mas critica, se observa que la
magnitud es de aproximadamente 238 fJ un numero bastante pequefio, haciendo un analisis para que el
lector pueda comprender un poco mejor lo que esto significa se recuerda la ecuacion de energia de un capa-

citor E, = %CV2 si se sustituye E, por 238 fJ, se supone un capacitor de 238uF y se despeja para V se ob-

tiene un resultado de 44.72uV, esto quiere decir que se puede realizar la operacion critica del circuito con
un capacitor de 238uF cargado a 44.72uV. Sin duda es una cantidad de energia bastante pequefa y este es
uno de los objetivos de la mejora continua de los circuitos integrados y de la electronica en general.

La ultima parte de este proyecto consta de la implementacion del ring pad, el die ya analizado es el co-
razén del proyecto pero quedaria incompleto sin poder usarlo en el exterior por lo que es necesario amplifi-
car la corriente de sus salidas y protegerlo de cualquier pico de voltaje en las entradas y de ruido ya sea en
la entrada o en la salida, las salidas también poseen proteccion ESD. Synopsys en sus librerias provee de
pads estandares que fueron los que se usaron, estos pads constan de un circuito de proteccion contra des-
cargas electroestaticas, un circuito que restablece la sefial a niveles de voltaje aceptables y un habilitador /
deshabilitador de la entrada o de la salida. Este habilitador no fue utilizado en el proyecto. Las Figuras 82 y
83 muestran las salidas usando los pads, se observa que el circuito sigue funcionando correctamente, que la
sefal de salida tiene un forma mas suave sin muchas perturbaciones como la salida del die, pero que el
retraso de propagacion es mas del doble, por lo que la nueva frecuencia de operacion es de 219.30 MHz
variando segun la carga que se conecte en el exterior del empaquetado. La Figura 81 muestra el proyecto
completamente terminado y funcional. Es importante agregar que en la ultima parte del proyecto se encon-
traron algunas librerias con errores de DRC y LVS, estas librerias son D411025 NS, IOVSS NS,
IOVDD NS, VSS NS, VDD NS y [1025 NS es muy recomendable solucionar estos problemas antes de
proceder con la agregacion de pad ring, esto aislara y solucionard muchos errores en el resultado final. El
resultado final mencionado con pad ring posee el problema de muchos errores de DRC y LVS y esto se
debe a los problemas mencionados con las librerias de los pads que requieren mucho tiempo para su solu-
cion, especificamente, estas librerias usan transistores grandes denominados n25 para amplificacion de
corriente, la implementacion de estos transistores en el /ayout es la que presenta los problemas. Quedara
como una mejora propuesta la solucion del circuito de pad ring, aunque el circuito es completamente fun-
cional, la parte de verificacion fisica es muy importante.
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VIII. CONCLUSIONES Y RECOMENDACIONES

H. Conclusiones

1. El laboratorio de electronica de la Universidad del Valle de Guatemala cuenta con aplicacio-
nes de disefio profesionales de circuitos a nanoescala.

2. Se ha generado exitosamente el primer circuito a muy gran escala usando las aplicaciones
profesionales proveidas por Synopsys.

3. Se obtuvo un retraso de propagacion final de 2.12 ns en el die y de 4.56 ns con la agregacion
de pads.

4. Se comprueba que la mejora en la tecnologia usada para la implementacion de circuitos inte-
grados provee ventajas energéticas considerables.

5. Algunas librerias de diseflo contienen errores de conexion.

6. No se realiz6 el método de logical effort debido a la utilizacién de librerias estdndares de di-
sefio.

Recomendaciones

[u—

Familiarizarse con el sistema operativo CentOS antes de empezar algin disefio.

2. Conocer los directorios importantes de instalacion de las aplicaciones y ubicacion de archivos
de las librerias que se pueden agregar a Custom Designer.

3. Seguir las fases de disefio sin obviar ninguna, al terminar de realizar alguna fase es una buena
practica realizar copias de seguridad de lo obtenido.

4. Usar la documentacion de las aplicaciones en caso se requiera una tarea muy especifica.

Usar algtin programa de conexidn remota para trabajar fuera del campus de la Universidad.

6. Verificar cada una de las librerias de forma individual para descartar errores en las mismas.

9]
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XI. ANEXOS

A. Video tutorial

https://www.youtube.com/watch?v=PuYQJpAKRSE

B. Articulo cientifico

En las siguientes paginas se encontrara un articulo cientifico extraido de este trabajo donde se tocan los
puntos mas importantes de esta investigacion. El articulo contiene principalmente el proceso de disefio del
Sumador / Restador de 32 bits.
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Disefio de un sumador/restador completo de 32

bits con tecnologia de 28 nandmetros
(Noviembre 2014)

Jonathan de los Santos (09375), Ingenieria electronica, UVG

Abstract— Nanoelectronics is a branch of electronics that specializes in
the design of integrated circuits, these ICs have a large number of compo-
nents inside. The process of designing an integrated circuit is complex
because of numerous rules that must be met so that the layout can be im-
plemented by a company dedicated to manufacturing as TSMC. This paper
describes the design process of an adder / subtractor 32 bit using 28-
nanometer technology design applications company Synopsys described.
Design phases suggests that Synopsys are made and then some data charac-
terizing the final design are measured.

Resumen— La nanoelectronica es una rama de la electronica que se de-
dica al diseflo de circuitos integrados, estos circuitos integrados poseen un
gran numero de componentes en su interior. El proceso de disefio de un
circuito integrado es complejo debido a numerosas reglas que se deben
cumplir para que el layout pueda ser implementado por alguna empresa
dedicada a la manufacturacion como la TSMC. En este articulo se describe
el proceso de disefio de un sumador/restador de 32 bits con tecnologia de 28
nandmetros usando aplicaciones de diseflo profesional de la empresa Sy-
nopsys. Se cumplen con las fases de disefio que Synopsys sugiere y luego se
miden algunos datos que caracterizan el disefio final.

Palabras clave— VLSI, DRC, LVS, LPE, Layout, transistores
CMOS, Synopsys.

1. INTRODUCCION

Las aplicaciones de diseflo de circuitos integrados son de gran
utilidad, estos circuitos pueden asemejarse a cualquier otro en

cuanto a funcionamiento final, pero durante el proceso de disefio
es necesario tomar muchos factores en cuenta. El proceso de fabri-
cacion de estos circuitos es bastante complejo, se usan maquinas
muy precisas para lograr la manufacturacion de componentes tan
pequefios. La cantidad de transistores que se ha logrado integrar en
una pequeia pieza de silicio en los tiempos actuales es impresionan-
te, tomando en cuenta que en 1971 el procesador 4004 tenia aproxi-
madamente 2300 transistores y uno de los procesadores de unos 43
afos después tiene mas de 2,600,000,000 transistores, denota un
crecimiento y mejora impresionante. [1]

El proyecto que se presenta en este articulo se trata del disefio de
un sumador/restador de 32 bits usando aplicaciones profesionales de
la empresa Synopsys, el proyecto se limita al disefio y no se imple-
mentara por razones de costo y tiempo. [2]

II. FASES DE DISENO

Galaxy Custom Designer es un ambiente de disefio que permite la
realizacion de circuitos a nanoescala de una manera eficiente usando
celdas de disefno estandar. Esto quiere decir que existen circuitos
conocidos a los que se le ha implementado un layout, un esquemati-
co y se han caracterizado para poder usarlos de forma confiable en
disefios mas complejos. Segun la documentacion de Galaxy Custom
Designer son 7 las fases de disefio, las cuales se presentan a conti-
nuacion. [2]

A. Circuito esquematico.

El disefio comienza al nivel de conexion de los diferentes compo-
nentes en un diagrama esquematico, cada componente debe tener sus
propiedades bien editadas para que las siguientes fases muestren
resultados fiables. Un diagrama esquematico es la conexion de los
componentes con sus propiedades fisicas correctas. El editor esque-
matico es muy parecido a los programas que se usan para la simula-
cion de circuitos, tiene las caracteristicas de orientacion (o transfor-
macion) que gira o refleja los componentes para hacer mas entendi-
ble el diagrama. Para un disefio mas ordena y mas profesional se
recomienda realizar bloques, al estilo de las conocidas cajas negras,
donde se tengan entradas y salidas, conocer la funcion que los rela-
ciona pero no forzosamente tener que saber qué hay dentro, esta es
una buena técnica para reciclar trabajos antiguos.

B. Circuito simulaciones.

Una vez que ya se tiene el esquematico y el simbolo agregado a la
vista de nuestra celda es necesario saber si funciona correctamente.
Recordar que el simbolo hace referencia al conjunto de transistores
que componen el circuito y es una forma compacta de verlo, si hay
algo no esperado en los resultados de simulacion el problema estara
en los transistores y no en el simbolo. La forma correcta de hacer
una simulacion es hacer otra celda para el testbench, esto porque no
se puede instanciar una celda dentro de si misma. Dentro de esta
celda para testbench se instancia el simbolo del componente que se
quiere probar y usando fuentes de tension se le inyectan sefiales
varias para analizar su funcionamiento. [4]

C. Analisis
La etapa de analisis es una etapa donde se debe verificar que los
datos obtenidos son los esperados, en este punto es necesario estar
seguros que todo funciona correctamente, que los niveles de voltaje
en salidas y entradas son correctos, etc. No es necesario, en esta
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etapa analizar tanto en aspectos como potencia, energia, tiempo o
alguna otra variable muy especifica ya que en este punto no se tiene
un circuito final porque faltan los parasitos que generara el Layout.
Existen varias aplicaciones para analizar los datos obtenidos como
Custom WaveView, Custom Explorer, Custom Explorer Ultra y
CosmosScope.

D. Schematic-Driven Layout

En esta fase de disefio se realiza la implementacion del layout que
sera el corazon del proyecto que se realiza, un buen disefio del la-
yout garantiza menos potencia, menos energia, tiempo de respuesta
menor. En el mundo de VLSI el disefio puede tener miles o hasta
millones de transistores, no es nada eficiente realizar el disefio tran-
sistor por transistor, esta opcion podria llegar a ser lo mejor en cuan-
to a desempefio pero llevara varios dias, meses o afos, dependiendo
del proyecto, es por eso que se usa un disefio en base a celdas, a
librerias de circuitos comunes ya realizadas que se colocan estratégi-
camente para lograr una mayor densidad de transistores por unidad
de area, luego de colocar las celdas se procede al proceso de ruteo
que une a cada una de las celdas y a los puertos de entrada y salida.
Se recomienda hacer una division en modulos del disefio y realizar
una combinacion estratégica del Generate Layout y el Pick and
Place. [3]

E. DRCyLVS

En esta fase de disefio se realiza la verificacion de las reglas de dise-
fio (Design Rules Checking) y la verificacion fisica del disefio (La-
yout Vs. Schematic). Esta fase es crucial para lograr un disefio que
pueda ser fabricado, es necesario cumplir con las reglas de disefio
para que la empresa de manufactura pueda implementar lo requerido
y es necesario que el esquematico, que ya se sabe que funciona co-
rrectamente por la fase de simulacion y andlisis, sea idéntico a lo
implementado en el Layout. Las violaciones encontradas son faciles
de ubicar y reparar manualmente debido a la interaccidon que se tiene
mediante el sistema operativo, IC Validator o Hercules y Custom
Designer. Cada vez que se resalta un error el editor de layout se
magnifica en las coordenadas donde se encontrd la violacion la cual
se marca con una malla amarilla. [5]

F. LPE

Esta seccion corresponde a la obtencién de un deck que se asemeje
mas a la realidad en cuanto a simulacidn, esto es debido a que se
ejecuta un proceso donde se calculan de manera muy acertada todas
las capacitancias, inductancias y resistencias parasitas que se gene-
ran con el disefio de layout que hasta este paso ya se tiene. El proce-
so es sencillo y de alta utilidad, la aplicacion que se integra al en-
torno de Galaxy Custom Designer es StarRC y como requisito ya se
debié haber realizado el LVS ya que se necesitan algunos archivos
generados en este proceso. Como resultado, al terminar el proceso,
se obtiene un deck con todo el circuito a nivel transistor mas capaci-
tores y resistencias (extraccion RC) interconectados entre si que
simulan las capacitancias y resistencias generadas entre las distintas
capas de metal del layout. [6]

G. Verificacion Post-Layout.

Esta fase de disefio es una fase extremadamente importante ya que
consiste en poder caracterizar nuestro circuito. Caracterizar se refie-
re a conocer aspectos del circuito que son cruciales en su funciona-
miento, como la potencia disipada, la energia necesaria, y el tiempo
maximo que se tarda para realizar una operacion. Esta ultima carac-
teristica resulta un poco dificil de encontrar, ya que es necesario
analizar cada una de las rutas que se usan para lograr un resultado,
con todas las posibles combinaciones en los vectores de entrada. En
ocasiones la ruta mas larga puede ser obvia, o si no lo es puede ser
facil realizar iteraciones con las combinaciones en los vectores de
entrada que produzcan un cambio en la salida, pero en proyectos
muy complicados no es ni obvio ni de facil iteracion. Para esto se
usan aplicaciones especificas como PrimeTime y NanoTime, la
primera de ellas a nivel de compuertas, cuando se tenga el circuito
descrito con un archivo HDL de Verilog y la segunda es a nivel de
transistores. El uso de las dos aplicaciones mencionadas con anterio-
ridad va mas alla del alcance de este articulo. [7]

III. DISENO EXPERIMENTAL

El circuito que se realizé es el siguiente con la diferencia que fue
extendido a 32 bits. [3]

A7 B7 A6 B6 A5 BS5 A4 B4 A3 B3 A2 B2 A1 B1 A0 BO 0

l | |
0 0 o s

| | | \ \

L L L L L
Y1919 191999 |VY
FA |« FA |« FA |« FA |« FA |« FA |« FA [« FA

' ' ' ' ' ' ' '

Cout s7 s6 S5 sS4 s3 s2 s1 S0
Figura 1: Circuito a implementar

Sobre este circuito se deben realizar las 7 fases de disefio usando la
iPDK de que Synopsys provee.
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IV. RESULTADOS
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Figura 4: Analisis de simulaciones
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Figura 5: Layout de die final

LAYOUT ERRORS RESULTS: CLEAM

484 & FREESE 33 k] #
# # # i 0F 3% %
# # FAEE O RAREAE 4 8 4
# # #3 ##

FEEF RAREY BRHEE 8 #34 #

Library name: Full_adder_32bits
Structurs nam=: Full_adds=r_32bit
Gen=rat=d by: IC Validator RHELE4 Relsas= J-2014.06.5P1.14030 2014/07/14

Figura 6: DRC Exitoso.

TOP BLOCK COMPARE RESULTS
PASS
[Full_Adder_32bit, Full_Adder_32bit]

IC Validator (R) Hierarchical Design Verification, RHEL64 Release J-2014.06.5P1.14030 2014/07/14
IC Validator Run: Time=0:00:09

Netlist Extraction Statistics

Library name:  Full Adder_3zbits
Structure name: Full Adder 3zbit
Generated by:  IC Validator RHELG4 Release J-2014.06.SP1.14030 2014/07/14
Layout vs. Schematic Statistics

_de._: /job_Full Adder_32bits.Full Adder_32zbit.icv.lvs/Full Adder 32bit.sck
LVS Errors:

1 successful equ:
0 failed equivalenci

Figura 7: LVS Exitoso.

71784 XMXI132|MMN6 XI132|MMNG:DRN XI132|MMNG:GATE VSS VSS nl05 SCA=72.6261 SCB=0.0449695 SCC=0.00974379 ad=0.02754p
2s=0.02754p 1=0.03u m=1 nf=1 nrd=0.377778 nrs=0.377778 pd=0.744u ps=0.744u w=0.27u
JERY XI122| M) YT132|M1807:DRN XT122|MAHT:GATE VSS VSS nl0S sCA=95.3961 SCR=D.0439186 scCx0. 0101565 ad=0. 042840
nrd=0.242857 nrs=0.242857 pd=1.044u ps=1.044u w=0.42u
:DRN XI132|MMP1:GATE VDD VDD pl05 SCA=59.1158 SCB=0.0550513 SCC=0.00733071 ad=0.03672p
.03672p 1-0.03u m-1 n w=0.36u
71787 XMXT132 | MME2 XT132|MMP2: 0623035 SCC=0.00738467 ad=0.03366p

N XI132|MMP3:GATE VDD
1 nrd=0.309091 nrs: .
XI132|MMP4:GATE XI132|MMP4:SRC VDD pl05 SCA=55.2788 508-0.0530149 SCC=0.00686298

.03u m=1 nf=1 nrd=0.309091 nrs=0.309091 pd=0.864u ps=0.864u w=0.33u

RN XI132|MMPS 1 77.9536 SCB=0.0763946 SCC=0.01096 ad=0.0408p as=0.0408p

5CC=0.00691423 ad=0.03366p

71789 Xix1132 | MME4. X1132 40P
ad=0.03366p as=0.03366p
71790 XMXI132|MMPS XI132|MMP
1-0.03u m=1 nf=1 nrd=0.
71791 XMXI132|MMP6 XI132|MMP
ad=0.0408p as=0.0408p
71792 XMXI132|MMPT XT132|MMP E
1-0.03u m=1 nf=1 nrd=0.136 nrs=0.136 pd=1.704u ps=1.704u w=0.75u

2.5933 SCB=0.0623076 SCC=0.00771724
.004u w=0.4u
0.0754836 SCC=0.0136763 ad=0.0765p as=0.0765p

Figura 8: Deck con parasitos (muestra)
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me(sec) in) 20 2n

Figura 9: Retraso de propagacion

it

Figura 10: Layout final con agregacion de pads.

I i

ime(seq) (in) 25 300 3in

Figura 11: Retraso de propagacion con pads.

TABLAI

CARACTERIZACION DEL CIRCUITO

Aspecto Especificacion
Tecnologia CMOS de 28 nm
Area de silicio (die) 30 x 30 (um)?
Retraso de propagacion 2.12 ns.
Frecuencia maxima de opera- 471.7 MHz
cién
Potencia promedio -112.7054 uW
Energia -238.0362 1]
Numero de transistores 1372
Densidad 152.4 MT/(cm)2
Retraso de propagacion (pads) 4.56 ns

V. DISCUSION DE RESULTADOS

a seccion anterior muestra un proceso de diseflo con resul-

tados satisfactorios, estos resultados fueron obtenidos des-

pués de muchas pruebas y correcciones tanto en la plata-

forma de trabajo como en el disefio en si. Los problemas en
la plataforma de trabajo resultaron de una instalacion correcta pero
de una configuracion en el sistema operativo CentOS incompleta.
Por ejemplo, cuando se necesitaba realizar el proceso de extraccion
de parasitos no se podia comunicar el Galaxy Custom Designer con
StarRC, el log de la ejecucion mostraba un error que indicaba que
uno de los archivos necesarios faltaba, este problema similar a mu-
chos otros ocurridos con las demas aplicaciones surgia debido a la
falta de alguna variable de entorno o la que existia apuntaba a un
directorio incorrecto. [7] Las variables de entorno son de vital im-
portancia para que las aplicaciones se puedan comunicar entre si y
también con el sistema operativo en general. Desde un principio se
sabia que se iban a tener problemas de este tipo por la experiencia
que se tiene en el uso de diversas distribuciones de Linux; aunque
los manuales de instalacion se siguieron al pie de la letra algunos de
ellos no especificaban el nombre de la variable de entorno o la di-
reccion que se sugeria era incorrecta, quiza por cambios en las nue-
vas versiones. Como primera aplicacion desarrollada en este am-
biente de trabajo se pretendia superar todos estos problemas con las
aplicaciones, dejar todas las configuraciones en un estado 6ptimo
para permitir que en el futuro se dedique Uinicamente al disefio sin
tener problemas con el entorno de trabajo. Un archivo de vital im-
portancia es SHOME/ . bashrc este archivo es un archivo de perso-
nalizacion del usuario hacia el sistema operativo, en el entorno Li-
nux se puede usar para diversas cosas, en este trabajo se ha usado
para especificar las variables de entorno necesarias para el correcto
funcionamiento de las aplicaciones de disefio. Es importante notar
que no es posible especificar las variables de entorno para todas las
aplicaciones que Synopsys provee por lo que es recomendable, al
instalar una aplicacion leer el manual de instalacion, especificamente
la seccion de configuracion con el entorno. Las aplicaciones queda-
ron apropiadamente instaladas dando al laboratorio de electronica de
la Universidad del Valle de Guatemala la suite de herramientas pro-
fesionales para disefio de circuitos a muy gran escala.

Synopsys recomienda el disefio en 7 fases que tienen un orden 16-
gico y hacen muy eficiente la obtencion de un resultado final. A
continuacion se iran detallando cada una de las fases haciendo refe-



Facultad de Ingenieria - Departamento de Ingenieria Electronica — Universidad del Valle de Guatemala 5

rencia a los resultados obtenidos y mencionando los hallazgos en-
contrados. La primera fase es la realizacion del diagrama esquemati-
co, la figura 2 muestra el disefio esquematico final como primera
fase de disefio. El circuito consta de varios sumadores completos de
1 bit puestos en cascada como lo muestra la figura 1 y compuertas
XOR que con la adicion de la entrada CIN convierten uno de los
vectores de entrada en complemento a 2. Es importante mencionar
que cada una de estas pequefas cajas negras estd construida a nivel
transistor en su interior.

Siguiendo el proceso de disefio se observa en la figura 3 que se
cred una caja negra, que es el sumador/restador completo con todos
los pines de entrada y salida que tendria ya implementado fuera del
empaquetado final, este esquematico para pruebas (testbench) se
realiz6 con dos objetivos, el primero fue para verificar el correcto
funcionamiento del disefio, que es la segunda fase de disefio, y el
segundo dejar una instancia que pueda ser usada en otros disefios
que requieran de un sumador/restador de 32 bits, esta es una buena
practica para hacer mas simples los procesos de disefio e implemen-
tacion. Al circuito de la figura 3 se le inyectaron sefiales para poder
proceder con las simulaciones respectivas y analizar el resultado de
las mismas. La versatilidad del graficador que ofrece la aplicacion
Custom Explorer y la integracion con Custom Designer hizo verda-
deramente simple esta labor. La figura 4 muestra el resultado de las
simulaciones graficando cada sefal de salida con respecto al tiempo.
Las sefiales cambian debido al cambio que se hizo intencionalmente
en las entradas CIN y SUB para analizar tanto la suma de los niime-
ros binarios como la resta de los mismos. El analisis de los resulta-
dos de la simulacion es la 3ra etapa de disefio, note que en esta fase
debemos obtener los resultados que deseamos, no tanto en aspectos
como potencia o tiempos de operacion pero si en los niveles de vol-
taje que se esperan en la salida. Por ejemplo, en el caso del de este
proyecto, en esta fase ya debe ser posible realizar sumas y restas, las
pruebas se realizaron a una frecuencia adecuada para saber que el
circuito si funciona. Varias veces fueron las que no se obtuvieron
resultados satisfactorios, al principio de creyd que era por la veloci-
dad en la que se realizaban las transiciones de los estados por lo que
se disminuy6 la frecuencia de operacion, y seguia sin funcionar.
Todo indicaba que era una mala conexion en la circuiteria que con-
forma el esquematico y asi fue. Puede ser una tarea realmente dificil
encontrar este tipo de errores, como el lector seguramente sabe por
simulaciones realizadas en otros entornos, por lo que se recomienda
tener mucho cuidado en la primera fase de disefio. Como es logico,
sin tener los resultados que se esperan no se puede pasar a las si-
guientes etapas de disefio.

La cuarta etapa de disefio es la generacion del Layout, una fase
que probablemente todos los interesados en la nanoelectronica estan
interesados en llegar. La maravilla que ahora son las aplicaciones de
disefio como las que Synopsys provee hacen de esta tarea, una labor
relativamente simple. El proceso se denomina Schematic Driven
Layout (SDL) como ya se ha explicado en las guias rapidas de uso
de las aplicaciones que conforman el marco teoérico de este docu-
mento. En esta fase se usé una combinacion estratégica de posicio-
namiento de las instancias en el editor de /ayout del generador auto-
matico y del pick and place esto para tener un disefio mas ordenado
y probablemente mas eficiente en cuanto a area. Luego de tener las
instancias debidamente alineadas y debidamente ubicadas se procede
a realizar el proceso de auto ruteo, esta funcién normalmente la
logra hacer en su totalidad Galaxy Custom Designer pero suele fallar

cuando se le indica que rutee todas las pistas de golpe. Lo que se
hizo fue rutear todas las rutas y al terminar el proceso en la “Custom
Designer Console” se imprime un sumario de cuales rutas fueron
completadas y cuales no, de las que no fueron ruteadas se repite el
proceso indicando que rutee solo éstas faltantes y asi hasta comple-
tar el 100% del ruteo. Si en alglin caso no fuera posible por parte del
programa hacer el ruteo puede rutearse a mano, estos errores se
encontraran en las siguientes fases de disefio. La figura 5 muestra el
die final obtenido.

La quita etapa es la de la verificacion fisica del disefio, los errores
obtenidos en el proceso de disefio fueron detecciones de violaciones
en las reglas de disefio y errores en la comparacion del esquematico
con el layout generado. Los problemas de DRC aunque en general
fue un niumero grande de violaciones encontradas fueron faciles de
solucionar debido a que el programa IC Validator como ya se ha
mencionado se comunica con el Layout Editor de Custom Designer
y ubica el error marcandolo con una malla amarilla (que puede ser
modificada desde IC Validator). En el proceso LVS también se
encontraron algunas desigualdades, LVS por ser un proceso de IC
Validator también se comunica con Custom Designer e identifica y
ubica el error de la misma forma que DRC. Los problemas que se
encuentren durante la ejecucion de LVS son producto de un mal
ruteo en las distintas capas de metal, y un mal ruteo puede originarse
por alguna deficiencia en la configuracion del Auto Route o porque
simplemente el software no fue capaz de hacer la conexion con las
restricciones impuestas. Normalmente el Auto Route realiza la
mayoria de conexiones sin ningin problema, en el proceso del dise-
flo del sumador/restador fueron 2 conexiones las que no se conecta-
ron automaticamente las cuales fueron detectadas facilmente con los
resultados del LVS y fueron realizadas las conexiones manualmente
que también se ofrece una forma muy intuitiva de realizarlo. Se
puede ver en las figuras 6 y 7 el resultado satisfactorio de las verifi-
caciones DRC y LVS respectivamente.

Hasta este punto ya se tiene un layout completamente terminado,
pero es necesario analizar como se comportara el circuito con este
disefio de layout, las simulaciones realizadas con anterioridad mues-
tran el correcto funcionamiento a nivel esquematico, pero no se
toman en cuenta los efectos que el layout agrega al circuito. Para
poder analizar estos efectos es necesario ejecutar un proceso llamado
LPE (Layout Parasitic Extaction), que realiza una extraccion de
capacitancias, inductancias y resistencias parasitas y las interconecta
en un deck con el resto del circuito a nivel de transistores, esta es la
sexta etapa de disefio. Este analisis es crucial para la verificacion de
potencia disipada y tiempo de retraso de propagacion y aspectos
mucho mas especificos que no se cubren en este documento, recor-
demos que este es un campo de investigacion muy amplio. La figura
8 muestra una parte del deck generado por este proceso, este deck se
agrega como una vista Hspice a la celda del proyecto y se procede a
verificar con el mismo festbench realizado con anterioridad, especi-
ficando en la jerarquia que se use el Hspice en lugar del Schematic.

Con el deck obtenido se hicieron varias simulaciones, este analisis
es la séptima y Ultima etapa de disefio, para la verificacion de que el
sistema seguia funcionando de forma correcta, el “cableado” que se
hace en el layout puede ser tan impactante que la aplicacion deje de
funcionar. Las simulaciones fueron exitosas sin embargo se ve la
clara presencia de capacitores interconectados en el circuito ya que
las salidas presentan la forma de carga y descarga de un capacitor
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mucho mas definida, es decir, una carga o descarga que requiere mas
tiempo. En la seccion de resultados varias son las figuras que mues-
tran el retraso de propagacion medido en el circuito, en este caso la
ruta critica es obvia y se obtiene cuando los valores de un vector de
entradas son todos 1, y las del otro son todas 0 y el CIN cambia de 0
a 1, o bien el CIN permanece en 0 y el bit menos significativo de un
vector, cambia de 0 a 1 mientras que el bit 0 del otro vector esta en
1. En cualquiera los dos casos el acarreo de salida de cada sumador
completo de 1 bit conmuta de 0 a 1, haciendo que en el siguiente
sumador se realice la misma conmutacién y asi hasta que COUT
realiza un flanco de subida, esta es la ruta critica y el tiempo para
realizar esa operacidn sera el tiempo maximo de operacion y la po-
tencia disipada por la fuente al realizar esa operacion sera la poten-
cia promedio maxima por operacion y por lo tanto la energia maxi-
ma que se requiere para hacer una operacion. En la tabla 1 se mues-
tran los resultados obtenidos de estas mediciones. Se observa que el
retraso de propagacion es de 2.12 ns, es un nimero de vital impor-
tancia ya que marcara la frecuencia a la que puede operar el disposi-
tivo que es de 471.7 MHz.

Otro aspecto a discutir es la energia usada para realizar la opera-
cion mas critica, se observa que la magnitud es de aproximadamente
238 fJ un niumero bastante pequefio, haciendo un analisis para que el
lector pueda comprender un poco mejor lo que esto significa se

.z ’ . 1 .
recuerda la ecuacion de energia de un capacitor E, = EC V2 si se

sustituye E,. por 238 fJ, se supone un capacitor de 238uF y se despe-
ja para V se obtiene un resultado de 44.72uV, esto quiere decir que
se puede realizar la operacion critica del circuito con un capacitor de
238uF cargado a 44.72uV. Sin duda es una cantidad de energia
bastante pequeia y este es uno de los objetivos de la mejora conti-
nua de los circuitos integrados y de la electronica en general. [10]

La ultima parte de este proyecto consta de la implementacion del
pad ring el die ya analizado es el corazdn del proyecto pero quedaria
incompleto sin poder usarlo en el exterior por lo que es necesario
amplificar la corriente de sus salidas y protegerlo de cualquier pico
de voltaje en las entradas y de ruido ya sea en la entrada o en la
salida, las salidas también poseen proteccion ESD. Synopsys en sus
librerias provee de pads estandares que fueron los que se usaron,
estos pads constan de un circuito de proteccion contra descargas
electroestaticas, un circuito que restablece la sefial a niveles de vol-
taje aceptables y un habilitador / deshabilitador de la entrada o de la
salida. Este habilitador no fue utilizado en el proyecto. La figuras 9
muestra las salidas usando los pads, se observa que el circuito sigue
funcionando correctamente, que la sefial de salida tiene un forma
mas suave sin muchas perturbaciones como la salida del die, pero
que el retraso de propagacion es mas del doble, por lo que la nueva
frecuencia de operacion es de 219.30 MHz variado seglin la carga
que se conecte en el exterior del empaquetado. La figura 9 muestra
el proyecto completamente terminado y funcional.

VI. CONCLUSIONES Y RECOMENDACIONES

A. Conclusiones
1. El laboratorio de electronica de la Universidad del Valle de
Guatemala cuenta con aplicaciones de disefio profesionales
de circuitos a nanoescala.

2. Se ha generado exitosamente el primer circuito a muy gran
escala usando las aplicaciones profesionales proveidas por
Synopsys.

3. Se obtuvo un retraso de propagacion final de 2.12 ns.

4. Se comprueba que la mejor en la tecnologia usada para la
implementacion de circuitos integrados provee ventajas
energéticas considerables.

B. Recomendaciones

1. Familiarizarse con el sistema operativo CentOS antes de
empezar algln disefio.

2. Conocer los directorios importantes de instalacion de las
aplicaciones y ubicacion de archivos de las librerias que se
pueden agregar a Custom Designer.

3. Seguir las fases de disefo sin obviar ninguna, al terminar de
realizar alguna fase es una buena préctica realizar copias de
seguridad de lo obtenido.

4. Usar la documentacion de las aplicaciones en caso se re-
quiera una tarea muy especifica.

5. Usar alglin programa de conexion remota para trabajar fue-
ra del campus de la Universidad.
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